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1 Overview

Keysight N9320B at a Glance 2
Front Panel Overview 4
Rear Panel Overview 9

Front and rear panel symbols 10

This chapter provides a description of the Keysight N9320B spectrum analyzer
and an introduction to the buttons, features, and functions of the front and rear
instrument panels.
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Keysight N9320B at a Glance

Features

The Keysight N9320B spectrum analyzer is a portable, swept
spectrum analyzer with a frequency range of 9 kHz to 3.0 GHz. It
can be a fundamental component of an automated system. It can
also be widely used in an electronic manufacturing environment
and in functional/final/QA test systems.

The Keysight N9320B spectrum analyzer primary features and
functions are described below:
= High Sensitive Measurement

The spectrum analyzer includes an optional pre-amplifier for
signals in the frequency range up to 3 GHz, enabling more sensitive
measurements. This feature is a great help in analysis of weaker
signals.

= High Accuracy Power Measurement

The N9320B supports Keysight U2000 series power sensors for
high accuracy power measurement as a power meter.

= Power Measurement Suite

The built-in one-button power measurement suite offers channel
power, ACP, OBW, and TOI measurements.

= Spectrum Emission Mask

provides a Pass/Fail testing capability with a mask for
out-of-channel emissions measurement.
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= Modulation Analysis Function

provides optional AM/FM and ASK/FSK modulation analysis
function. (AM/FM: Option-AMA ASK/FSK: Option-DMA)

= Tracking Generator

provides an RF source for scalar network analysis (Option-TG3).

For the latest product information, please refer to the link below:
http://www.keysight.com/find/n9320b
For the latest option information, please refer to the link below:

http://www.keysight.com/find/sa_upgrades
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Front Panel Overview
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Screen 6.5 inch TFT color screen shows information of the
current function, including the signal traces, status indicators, and
instrument messages. Labels for softkeys are located on the
right-hand side of the screen.

Softkeys are the unlabeled keys next to the screen. They activate
functions displayed to the left of each key.

Amplitude activates the reference level function and accesses
the amplitude softkeys, with which you set functions that affect
data on the vertical axis.

SPAN  sets the frequency range symmetrically about the center
frequency. The frequency-span readout describes the total
displayed frequency range.

Frequency activates the center-frequency function, and accesses
the menu of frequency functions.

Function Keys relate directly to the following main functions:

 Preset/System (Local) accesses the softkeys to reset the
analyzer to a known state, if the analyzer is in the remote mode,
pressing this key returns the analyzer to the local mode and
enables front-panel control.
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e Auto Tune searches the signal automatically and locates the
signal to the center of the graticule. see "Auto Tune" on
page 94.

« BW/Avg activates the resolution bandwidth function and
accesses the softkeys that control the bandwidth functions and
averaging.

» Sweep/Trig accesses the softkeys that allow you to set the
sweep time, select the sweep mode and trigger mode of the
analyzer.

* View/Trace accesses the softkeys that allow you to store and
manipulate trace information.

« Det/Display accesses the softkeys that allow you to configure
detector functions and control what is displayed on the
analyzer, including the display line, graticule and annotation, as
well as the testing of trace data against entered limits.

* MODE selects the measurement mode of your analyzer.

« Meas accesses the softkeys that let you make transmitter
power measurements such as adjacent channel power,
occupied bandwidth, and harmonic distortion, etc.

e Marker accesses the marker control keys that select the type
and number of markers and turns them on and off.

* Marker— accesses the marker function softkeys that help you
with the measurement.

» Peak Search places a marker on the highest peak.
» File accesses the softkeys that allow you to configure the file
system of the analyzer.

Arrow Keys The up and down arrow keys shift the selected item
when you press [MODE] hardkey; you can also change the mode
by rotating the knob.

Knob The front panel knob increases or decreases a value, a
numeric digit, or scrolls up and down to select an item in a list.
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Data Control Keys includes the numeric keypad, ENTER key and
backspace key, change the numeric value of an active function
such as center frequency, start frequency, resolution bandwidth,
and marker position.

RF IN connector is the signal input for the analyzer. The
maximum damage level is average continuous power +40 dBm,
DC voltage 50 VDC or max pulse voltage 125 V. The impedance is
50 Q. (N-type female).

PROBE POWER connector provides power for high-impedance
AC probes or other accessories (+15 V, =12 V, 150 mA maximum).

CAL OUT connector provides an amplitude reference signal
output of 50 MHz at -10 dBm (BNC female).

TG SOURCE connector N-type female, is the source output for
the built-in tracking generator. The impedance is 50 Q. (for Option
TG3)

If the tracking generator output power is higher than the maximum
power that the device under test can tolerate, it may damage the
device under test. Do not exceed the maximum power of DUT.

Standby Switch switches on all functions of the analyzer. To
switch the analyzer off, press the switch for at least 2 seconds. This
deactivates all the functions but retains power to internal circuits
so long as the analyzer is connected to line power.

On LED (green) lights when the analyzer is switched on.

Standby LED (orange) lights when the analyzer is connected to
the line power.

Remote LED lights when the analyzer is remotely controlled by a
PC via the USB host interface on the rear panel.

USB Device Connector provides a connection between external
USB devices and the analyzer, such as a USB memory device.
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Display Annotations

1.000000 MHz

Full Span

Zero Span

Last Span

Item Description Notes (Associated function key)

1 Amplitude scale [Amplitude] > Scale Type

2 Detector mode [Det/Display] > Detector

3 Reference level [Amplitude] > Ref Level

4 Active function block The function in use

5 Time and date display [Preset/System] > Time/Date

6 RF attenuation [Amplitude] > Attenuation Auto

7 Marker frequency [Marker] or

[Marker] > Function > Frequency

Counter

8 Uncal indicator The readout of amplitude is
uncalibrated.

9 Marker amplitude [Marker]

10 External reference An external frequency reference is in use.
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Remote mode

The analyzer is in remote mode

12 Key menu title Dependent on key selection.
13 Softkey menu Refer to "Key Reference" for details.
Dependent on current function key
selection.
14 Frequency span [SPAN]
15 Sweep time [Sweep/Trig] > Sweep Time
16 Video bandwidth [Bw/Avg] > Video BW
17 Display status line Display status and instrument messages.
18 Resolution bandwidth [Bw/Avg] > Res BW
19 Trigger/Sweep [Sweep/Trig]
F - free run trigger
L - line trigger
V - video trigger
E - external trigger
C - continuous sweep
S - single sweep
20 Continuous peak [Peak Search] > Continuous pk
21 Signal track [SPAN] > Span
22 Internal preamp [Amplitude] > Int Preamp
23 Key menu title Dependent on key selection
24 Trace mode [Trace]
W - clear write
M - maximum hold
m - minimum hold
V - view
S - store blank
25 Average [Bw/Avg] > Average On Off
VAvg - video average
PAvg - power average
26 Display line [Det/Display] > display Line On Off




Rear Panel Overview

Overview
Rear Panel Overview

@eosooeoo
000080000
)

000080000
©

REFOUT 0®00800

o

10

REF OUT connector provides a frequency of 10 MHz, amplitude of
-10 dBm reference output. (BNC female)

REF IN connector accepts an external timebase with a frequency
of 10 MHz, amplitude of -5 to +10 dBm. (BNC female)

Kensington Lock lock the instrument and keep its safety.

LAN port A TCP/IP Interface that is used for remote analyzer
operation.

EXT TRG IN (TTL) connector accepts an external voltage input,
the positive edge of which triggers the analyzer sweep function.
(BNC female)

Power switch isolates the analyzer from the AC line power. After
switch on, the analyzer enters into standby mode and the orange
standby LED on the front panel lights.

AC Power Receptacle accepts a three-pin line power plug.

VGA connector provides the video output signal to an external
monitor or projector. (D-sub 15-pin female)

USB Host connector provides a connection between the analyzer
and an PC for remote control.

GPIB connector (Option GO1) is an optional interface. GPIB
supports remote analyzer operation.
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Instruction manual symbol: indicates that the user must refer to specific
instructions in the manual.

CE mark: a registered trademark of the European Community.

Shows that this is an Industrial Scientific and Medical Group 1 Class A
product. (CISPR 11, Clause 4)

The CSA mark: a registered trademark of the Canadian Standards
Association International.

The ISM device complies with Canadian Interference-Causing Equipment
Standard-001.
Cet appareil ISM est conforme a la norme NMB-001 du Canada.

All Level 1, 2 or 3 electrical equipment offered for sale in Australia and
New Zealand by Responsible Suppliers must be marked with the
Regulatory Compliance Mark (RCM Mark).

marks the “on/standby” position of the switch.
indicates that the instrument requires AC power input.

indicates this product complies with the WEEE Directive(2002/96/EC)
marking requirements and you must not discard this equipment in
domestic household waste. Do not dispose in domestic household waste.

indicates the time period during which no hazardous or toxic substance
elements are expected to leak or deteriorate during normal use. Forty
years is the expected useful life of the product.

KC mark: as Korea Certification. This equipment is Class A suitable for
professional use and is for use in electromagnetic environments outside of
the home.

To return unwanted products, contact your local Keysight office, or refer
to http://www.keysight.com/environment/product/
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This chapter helps you in preparing the spectrum analyzer for use and provides
the information to start using the spectrum analyzer correctly.
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Check the Shipment and Order List
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After receiving the shipment, first check the shipment and your
order list.

Inspect the shipping container and the cushioning material for
signs of stress. Retain the shipping materials for future use, as you
may wish to ship the analyzer to another location or to Keysight
Technologies for service. Verify that the contents of the shipping
container are complete.

Each spectrum analyzer includes the following accessories as
standard:

Item Description

USB cable (A-B) Connection for remote control
N-BNC adapter and BNC cable Connection for alignment
Three-pin power cord Specific to shipping location

Help kit CD-ROM HSA and BSA PC Software
Keysight 10 libraries suite
N9320B documentation

Shipping Problems?
If the shipping materials are damaged or the contents of the
container are incomplete:

Contact the nearest Keysight Technologies office to arrange for
repair or replacement. You will not need to wait for a claim
settlement.

Keep the shipping materials for the carrier’s inspection.

If you must return an analyzer to Keysight Technologies, use the
original (or comparable) shipping materials.

For any questions about your shipment, please contact Keysight
Technologies for consulting and service.
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Verify if that the shipment includes your ordered options by
checking the option label on the shipping container:

Option Description Part number
PA3 3 GHz Preamplifier N9320B-PA3
GO1 GPIB interface N9320B-GO1
AMA AM/FM demodulation N9320B-AMA
DMA ASK/FSK demodulation N9320B-DMA
TG3 3 GHz tracking generator N9320B-TG3
EMF EMI filter N9320B-EMF
GO1 GPIB interface N9320B-GO1
TR1 RF training kit N9320B-TR1
1HB Handle and bumpers N9320B-1HB
1CM Rackmount kit N9320B-1CM
1TC Hard transit case N9320B-1TC
UK6 Commercial calibration certificate  N9320B-UK6

with testing data

Unless specified otherwise, all options are available when you order
a spectrum analyzer; some options are also available as kits that
you can order and install/activate after you receive the analyzer.
Order kits through your local Keysight Sales and Service Office.

At the time of analyzer purchase, options can be ordered using
your product number and the number of the option you are
ordering. For example, if you are ordering option TG3, you would
order N9320B-TG3.

If you are ordering an option after the purchase of your analyzer,
you will need to add a K to the product number and then specify
which option you are ordering. For example, N9320BK-TG3.

For the latest information on Keysight N9320B spectrum analyzer
options and upgrade kits, visit the following Internet URL:
http://www.keysight.com/find/n9320b

13
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Safety Notice
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Read the following warnings and cautions carefully before
powering on the spectrum analyzer to ensure personal and
instrument safety.

Always use a well-grounded, three-pin AC power cord to connect
to power source. Personal injury may occur if there is any
interruption of the AC power cord. Intentional interruption is
prohibited. If this product is to be energized via an external auto
transformer for voltage reduction, make sure that its common
terminal is connected to a neutral (earthed pole) of the power

supply.

Personal injury may result if the spectrum analyzer covers are
removed. There are no operator-serviceable parts inside. To avoid
electrical shock, refer servicing to qualified personnel.

Electrical shock may result if the spectrum analyzer is connected
to the power supply while cleaning. Do not attempt to clean
internally.

Prevent damage to the instrument and ensure protection of the
input mixer by limiting average continuous power input to +33
dBm, DC voltage to 50 VDC with >10 dB input attenuation.
Instrument damage may result if these precautions are not
followed.

To install the spectrum analyzer in other racks, note that they may
promote shock hazards, overheating, dusting contamination, and
inferior system performance. Consult your Keysight customer
engineer about installation, warranty, and support details.
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Power Requirements

The spectrum analyzer has an auto-ranging line voltage input. The
AC power supply must meet the following requirements:

Voltage: 100 to 240 VAC (90 to 264 VAC)
Frequency: 50 to 60 Hz

Power: Maximum 100 W

AC Power Cord

The analyzer is equipped with a three-wire power cord, in
accordance with international safety standards. This cable grounds
the analyzer cabinet when connected to an appropriate power line
outlet. The cable appropriate to the original shipping location is
included with the analyzer.

Various AC power cables are available that are unique to specific
geographic areas. You can order additional AC power cables for
use in different areas. The table AC Power Cords lists the available
AC power cables, the plug configurations, and identifies the
geographic area in which each cable is appropriate.

The detachable power cord is the product disconnecting device. It
disconnects the mains circuits from the mains supply before other
parts of the product. The front panel switch is only a standby
switch and do not disconnect instrument from LINE power.

15
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AC Power Cords

Plug Type Cable Part Plug 2 For use in
Number Description | Country & Region

8121-1703 |BS 1363/A  |Option 900

1 United Kingdom, Hong
250V 10A \ Kong, Singapore, Malaysia
8120-0696 |AS Option 901
3112:2000

Australia, New Zealand

250V 10A

8120-1692 |IEC 83 C4 Option 902

) Continental Europe, Korea,
=7 250V 16A Indonesia, Italy, Russia

8120-1521 |CNS 10917-2|Option 903
/NEMA United States, Canada,
125V 10A 5-186P Taiwan, Mexico

8120-2296 |SEV 1011 Option 906
% 10A Switzerland

Ai 8120-4600 |SABS 164-1 |Option 917
, South Africa, India

-

230V 15A
8120-4754 |JIS C8303 Option 918
Japan
125V 15A P
8120-5181 |SI 32 Option 919
. Israel
250V 16A
8120-8377 |GB 1002 Option 922
China
g 250V 10A

a. Plug description describes the plug only. The part number is for the complete cable assembly.

16
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Power On and Check

Connect the AC power cord into the instrument. Insert the plug
into a power socket provided with a protective ground. Set the tilt
adjustors for your preference.

Figure 1 Plug in and angle adjustment

Press the AC line switch | 4] on the rear panel. The standby LED on
the front panel will light and the spectrum analyzer is in standby
mode (AC power applied).

Press the standby switch () on the front panel. The On LED will
light, and the spectrum analyzer boots up.

Self-initialization takes about 25 seconds; the spectrum analyzer
then defaults to the menu mode. After power on, let the spectrum
analyzer warm up for 45 minutes for stabilization.

The front panel switch is a standby switch only; it is not a
power switch. To completely disconnect the spectrum
analyzer from the AC line power, shut off the power switch on
the rear panel.

17
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Running Internal Alignments

To meet the instrument performance specifications, the analyzer
must periodically be manually aligned.

1 Connect a BNC cable with the N-BNC adapter between the CAL
OUT and RF IN front panel connectors.

2 After 15-minute warm up, press > Alignment > Align > All
The self alignment takes about 5 minutes.

When an alignment is being run, there will be an audible
clicking sound as the attenuator settings are changed. This
sound is not an indication of a problem. Please refer to
"Alignment" on page 159 for further information.

Check for Instrument Messages

The spectrum analyzer has two categories of instrument messages:
error and warning messages. A error message is triggered by
operation errors, for example, parameter setting conflicts or data
input that is out of the range of a parameter. An warning message
may be triggered by hardware defects which could result in
damage to instrument.

Here are some tips to check the instrument messages.

1 Check the display to see if any messages display in the status bar.
Press g > More > Show Errors to review each message. Refer to

Chapter 5, "Instrument Messages" for detailed system message
descriptions.

2 When you have reviewed and resolved all of the error messages,
press §&f > More > Show Errors > Clear error queue to delete the

messages.

3 Cycle the power to the analyzer and re-check to see if the
instrument messages are still there.

4 If the error messages cannot be resolved, please contact the
Keysight Customer Contact Center for assistance or service.

18



Getting Started
Environmental Requirements

Environmental Requirements

Ventilation

Keysight Technologies has designed this product for use in
Installation Category I, Pollution Degree 2, per IEC 61010-1.

Keysight has designed the spectrum analyzer for use under the
following conditions:

Indoor use

Altitude < 3,000 meters

Operating temperature range: +5 to +45°C;
Storage temperature range: -20 to +70°C
Relative humidity range 15% to 95% at 40°C

Ventilation holes are located on the rear panel and one side of the
spectrum analyzer cover. Do not allow these holes to be
obstructed, as they allow air flow through the spectrum analyzer.

When installing the spectrum analyzer in a cabinet, do not restrict
the convection of the analyzer. The ambient temperature outside
the cabinet must be less than the maximum operating temperature

of the spectrum analyzer by 4 °C for every 100 watts dissipated
within the cabinet.

Cleaning Tips

To prevent electrical shock, disconnect the spectrum analyzer from
line power before cleaning. Use a dry cloth or one slightly
dampened with water to clean the external case parts. Do not
attempt to clean internally.

19
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Rack Mount

It is recommended to use the Keysight rackmount kit (option TCM)
to install the spectrum analyzer into a rack.

Do not attempt to rack mount the spectrum analyzer by the front
panel handles only. This rackmount kit will allow mounting of the
spectrum analyzer with or without handles.

Refer to the following instructions when installing the rackmount
kit on the spectrum analyzer.

Remove feet, key-locks and tilt stands.

Remove side trim strips and one middle screw per side.

SIDE TRIM
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3 Attach rackmount flange and front handle assembly with 3 screws
per side.

FRONT HANDLE
ASSEMBLY

4 Attach the spectrum analyzer to the rack using the rackmount
flanges with two dress screws per side.

Installing the spectrum analyzers into other racks may promote
shock hazards, overheating, dust contamination, and inferior
system performance. Consult your Keysight customer engineer
about installation, warranty, and support details.

21
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South Korea Class A EMC Declaration

This equipment is Class A suitable for professional use and is for
use in electromagnetic environments outside of the home.
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Helpful Tips

The following contains information to help in using and maintaining
the instrument for optimum operation, including alignment,
external reference, firmware update and option activation.

Perform a Self Alignment

The N9320B provides a self alignment function to manually align
the amplitude based on the time base. The analyzer should warm
up for approximately 30 minutes before self alignment.

When the self aligment function is triggered, the current
measurement is interrupted and a gauge displays on the LCD. The
gauge simply indicates alignment is in process. When the aligment
is finished, the interrupted measurement restarts.

Please refer to the operation procedures as below:

1 Connecta BNC cable with a N-BNC adapter between the CAL OUT
and RF IN front panel connectors.

2 Press {§§# > Alignment > Alignment > Align (Ext Cable) to initiate
the alignment.

Perform a Time Base Calibration

The N9320B provides a manual calibration function to calibrate the
time base. The analyzer should warm up for approximately 30
minutes before calibration.

When the calibration function is triggered, the current
measurement is interrupted and a gauge displays on the LCD. The
gauge simply indicates calibration action rather than calibration
course.

23
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Please refer to the operation procedures as below:

Connect a 10 MHz reference TTL signal from external signal
generator to EXT TRG IN connectors on rear panel.

Press B&ER4 > Alignment > Timebase to initiate a calibration.

System

When the calibration is finished, the interrupted measurement
restarts.

Using an External Reference

To use an external 10 MHz source as the reference frequency,
connect the external reference source to the REF IN connector on
the rear panel. An EXT REF indicator will display in the upper bar of
the display. The signal level must be in the range of -5 to +10 dBm.
When the reference signal is ready, the instrument switches the
reference from time base to the external reference.

Enable an Options

24

Option license key information is required to enable product
options. Contact your nearest Keysight office for purchasing a
license. Refer to the procedures below to activate the options you
have purchased.

Press [ > More > More > Licensing > Option

Enter the option number to be enabled. Press [Enter] to confirm
your input.

Press License key, enter the license key in the onscreen window.
Press [Enter] to confirm your input and terminate the license key
input.

Press Activate License. The option will be enabled immediately.

The analyzer provides the trial license with limited time usage of
the interested options.
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Firmware Upgrade

Press 8 > More > Show software to view the firmware revision
of your analyzer. If you call Keysight Technologies regarding your
analyzer, it is helpful to have this revision and the analyzer serial

number available.

Follow this procedure to finish the firmware update:

1 Download the firmware package from web. Extract and copy the
file version and folder “n9320b” into the root directory of a USB
stick.

2 Plug the USB stick into the connector. Press > Upgrade

The analyzer will perform the update process automatically. The
upgrade procedure will take several minutes. Once the upgrade is
completed, please follow the instruction to reboot the instrument.

Any interruption during the update process will result in
update failure and system data lost. Do not remove the USB
storage device until the update is finished.

|0 Configuration

The N9320B spectrum analyzer provides three types of 10
connnection: USB, LAN and optional GPIB interface. Press s >

{IO Configure} to select the corresponding interface as your need.

USB

Select USB to enable the USB connection for remote control.

LAN

The N9320B supports LAN port connection for remote control.
Press > {More} > {More} > {IP Admin} to set the IP parameters
for the network connection.

25



Getting Started
Helpful Tips

26

Press {IP Select Static} to manually set the IP address, gateway
and subnet mask with the proper LAN information, or just press {IP
Select DCHP} to set the IP address in LAN dynamically according
DCHP.

Press {Apply} to enable all the parameters you set.

Press > {I0 Configure} > {LAN} to enable the LAN connection
according to the IP configuration you set.

GPIB

Press > {More} > {More} > {GPIB Address} to set the GPIB
address for the analyzer.

Press > {I0 Configure} > {GPIB} to enable the GPIB
connection. The GPIB softkey is only vaild after the option GO1
installed.

Power Preset Last

The option C20 provides the capability to save the last state of the
analyzer before power off/power failed (essentially uplugging,

replugging).

Press > {Pwr On/Preset} > {Power On Last} to activate this
function. For the standard N93208, this operation only save the
last state if the analyzer is turned off by the front panel power

switch.
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This chapter provides information on the analyzer functions and specific
measurements capabilities of the spectrum analyzer.
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Making a Basic Measurement

28

In this guide, the keys labeled with [ ], for example,
[Preset/System] refer to front-panel hardkeys. Pressing many of the
hardkeys accesses softkey menus that are displayed along the right
side of the screen. The softkey menu labels are aligned so that they
are located next to the softkeys at the right side of the display
screen. For example, Preset is a softkey menu selection when first
pressing [Preset/System].

Using the Front Panel

Knob
Arrow Keys

Numeric Keys

Unit Softkeys
Enter Key

Back Key

Toggle
Submenu
Choice

Adjust

This section provides you with the information on using the front
panel of the spectrum analyzer.

Entering Data

When setting the measurement parameters, there are several ways
to enter or modify the value of the active function:

Increments or decrements the current value.
Increments or decrements the current value by a step unit.

Enters a specific value. Then press the desired terminator (either a
unit softkey, or [Enter] hardkey).

Terminate (enter) a value with a unit softkey from the menu.

Terminates an entry when no unit of measure is required, or the
instrument uses the default unit.

To delete the current input digit prior to entering the value.

Using Softkeys

Softkeys are used to modify the analyzer function parameter
settings. Some examples of softkey types are:

Turn on or off an instrument state.
Displays a secondary menu of softkeys, {More}.
Selecting from a list of standard values or filenames.

Highlights the softkey and sets the active function.
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Presetting the Spectrum Analyzer

Factory Preset

User Preset

Preset function provides a known instrument status for making
measurements. There are two types of presets, factory and user:

When this preset type is selected, it restores the analyzer to its
factory-defined state. A set of known instrument parameter
settings defined by the factory. Refer to “Factory Default Preset
State” on page 159 for details.

Restores the analyzer to a user-defined state. A set of user defined
instrument parameter settings saved for assisting the user in
quickly returning to known a instrument measurement setup.

Press > Pwr on/Preset > Preset Type to select the preset
type.

When Preset Type is set to Factory, pressing > Preset
triggers a factory preset condition. The instrument will immediately

return to the factory default instrument parameter setting.

When Preset Type is set to User, pressing > Preset displays

both User Preset and Factory Preset softkeys. The user may then
select the preset desired from the softkey menu selections.

Setting up a User Preset

To quickly return to instrument settings that are user defined,
perform the following steps to save the instrument state as the
user-defined preset:

Set the instrument parameters to the values and settings
necessary for the user preset state. This would include the
frequency, span, amplitude, BW, and measurement type and any
other setup details desired.

Press > Pwr on/Preset > Save User Preset, to save the
current instrument settings as the ‘user preset’ state. The user
preset will not affect the default factory preset settings. User preset

settings can be changed and saved at any time.
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Viewing a Signal
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Refer to the procedures below to view a signal.

Press > Pow on/Preset > Preset Type > Factory to enable the

factory-defined preset state.

Press > Preset to restore the analyzer to its factory-defined
state.

Connect the 10 MHz REF OUT on the rear panel to the front-panel
RF IN.
Setting the Reference Level and Center Frequency

Press > 10 > dBm to set 10 dBm reference level.
Press > 30 > MHz to set 30 MHz to center frequency.

Setting Frequency Span
Press > 50 > MHz to set 50 MHz frequency span.

Changing the reference level changes the amplitude value of the
top graticule line. Changing the center frequency changes the
horizontal placement of the signal on the display. Increasing the
span will increase the frequency range that appears horizontally
across the display.

Reading Frequency and Amplitude
Press to place a marker (labeled 1) on the 10 MHz peak.
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Note that the frequency and amplitude of the marker appear both
in the active function block, and in the upper-right corner of the
screen.

Figure 3-1 10 MHz Internal Reference Signal

Active function block Marker Annotation
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Use the knob, the arrow keys, or the softkeys in the Peak Search
menu to move the marker. The marker information will be
displayed in the upper-right corner of the screen.

Changing Reference Level

Press [ and note that reference level (Ref Level) is now the
active function.

Press > Mkr-> Ref Lvl.

Changing the reference level changes the amplitude value of the
top graticule line.
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Measuring Multiple Signals
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This section provides the information on how to measure multiple
signals.

Comparing Signals on the Same Screen Using Marker

The delta marker function allows the user to compare two signals
when both appear on the screen at the same time.

In the following example, harmonics of the 10 MHz reference signal
available are used to measure frequency and amplitude differences
between two signals on the same screen. Delta marker is used to
demonstrate this comparison.

Preset the analyzer:

Press [l > Preset (With Preset Type of Factory)

Connect the rear panel REF OUT to the front panel RF IN.

Set the analyzer center frequency, span and reference level to view
the 10 MHz signal and its harmonics up to 50 MHz:

Press > 30 > MHz

Press > 50 > MHz

Press (¥ > 10 > dBm

Place a marker at the highest peak on the display (10 MHz):
Press (R

The marker should be on the 10 MHz reference signal. Use the
Next Pk Right and Next Pk Left softkeys to move the marker from
peak to peak.

Anchor the first marker and activate a second marker:
Press ¥ > Delta » Delta (On)

The label on the first marker now reads 1R, indicating that it is
marking the reference point.
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Move the second marker to another signal peak using the
front-panel knob or by using Peak Search.

Press §$#a) > Next Peak or

Press > Next Pk Right or Next Pk Left. Continue pressing the
Next Pk softkeys until the marker is on the correct signal peak.

The amplitude and frequency differences between the markers are
displayed in the active function block.

Figure 3-2  Delta pair marker with signals on the same screen
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To increase the resolution of the marker readings, turn on the
frequency count function. For more information, refer to "Improving
Frequency Resolution and Accuracy" on page 46.
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Comparing Signals not on the Same Screen
Using Marker Delta

34

The analyzer will compare the frequency and amplitude differences
between two signals which are not displayed on the screen at the
same time. (This technique is useful for harmonic distortion tests.)

In this example, the analyzer’'s 10 MHz signal is used to measure
frequency and amplitude differences between a signal on screen,
and another signal off screen. Delta marker is used to demonstrate
this comparison.

Preset the analyzer:

Press ls’ggg{l > Preset (With Preset Type set to Factory)

Connect the rear panel REF OUT to the front panel RF IN.

Set the center frequency, span and reference level to view only the
50 MHz signal:

Press > Center Freq > 50 > MHz
Press > Span » 25 > MHz
Press > Ref Level > 10 > dBm

Place a marker on the 50 MHz peak and then set the center
frequency step size equal to the marker frequency (10 MHz):
Press [N

Press > Mkr -> CF Step

Activate the marker delta function:
Press > Delta > Delta (On)
Increase the center frequency by 10 MHz:

Press > Center Freq,

The first marker moves to the left edge of the screen, at the
amplitude of the first signal peak.
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Figure 3-3 shows the reference annotation for the delta marker
(1R) at the left side of the display, indicating that the marker set at
the 50 MHz reference signal is at a lower frequency than the
frequency range currently displayed.

Figure 3-3  Delta Marker with Reference Signal Off-Screen
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The delta marker appears on the peak of the 100 MHz component.
The delta marker annotation displays the amplitude and frequency
difference between the 50 and 100 MHz signal peaks.

Press > Off to turn the markers off.
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Resolving Signals of Equal Amplitude

In this example a decrease in the resolution bandwidth (RBW) is
used in combination with a decrease in video bandwidth (VBW) to

resolve two signals of equal amplitude with a frequency separation
of 100 kHz.

Figure 3-4  Setup for obtaining two signals

Signal Generator Signal Generator Spectrum Analyzer
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Notice that the final RBW selection to resolve the signals is the
same width as the signal separation while the VBW is slightly
narrower than the RBW.

1 Connect two sources to the analyzer input as shown above.

2 Setone source to 300 MHz. Set the frequency of the other source
10 300.1 MHz. Set both source amplitudes to -20 dBm.

3 Setup the analyzer to view the signals:
Press [ > Preset (With Preset Type of Factory)
Press > 300 > MHz
Press > 300 > kHz
Press (8280 > 2 > MHz

A single signal peak is visible. See Figure 3-5 for example.
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If the signal peak is not present on the display, increase the
frequency span out to 20 MHz, turn signal tracking on, decrease
the span back to 2 MHz and turn signal tracking off:

Press > Span > 20 > MHz

Press (5N

Press > Signal Track (On)

Press (280 > 2 > MHz

Press > Signal Track (Off)

Figure 3-5  Unresolved Signals of Equal Amplitude

Change the resolution bandwidth (RBW) to 100 kHz so that the
RBW setting is less than or equal to the frequency separation of the
two signals:

Press > 100 > kHz

Notice that the peak of the signal has become flattened indicating
that two signals are present.

Decrease the video bandwidth to 3 kHz:
Press > Video BW > 3 > kHz

Two signals are now visible as shown in Figure 3-6. Use the
front-panel knob or arrow keys to further reduce the resolution
bandwidth and better resolve the signals.
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Decreasing the resolution bandwidth improves the resolution of the
individual signals and increases the sweep time.

Figure 3-6  Resolving Signals of Equal Amplitude

Atten 10 dB

For fastest measurement times, use the widest possible resolution
bandwidth. Under factory preset conditions, the resolution
bandwidth is coupled to the span.
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Resolving Small Signals Hidden by Large Signals

This example uses narrow resolution bandwidths to resolve two RF
signals that have a frequency separation of 50 kHz and an
amplitude difference of 60 dB.

1 Connect two sources to the RF IN as shown in Figure 3-4.

2 Setone source to 300 MHz at —-10 dBm. Set the other source to
300.05 MHz at -70 dBm.

3 Set the analyzer as follows:
Press rgggm > Preset. (With Preset Type of Factory)
Press > 300 > MHz
Press > 30 > kHz
Press > 500 > kHz
4 Set the 300 MHz signal to the reference level:

Press gg;'\h

Press > Mkr -> Ref Lvl

The 30 kHz filter shape factor of 15:1 has a bandwidth of 450 kHz
at the 60 dB point. The half-bandwidth (225 kHz) is NOT narrower
than the frequency separation of 50 kHz, so the input signals can
not be resolved.

Figure 3-7  Unresolved Small S|gnal from large signal
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Reduce the resolution bandwidth filter to view the smaller signal.
The smaller signal will be hidden by the larger signal when the
bandwidth settings are wider, as in Figure 7. Reducing the RBW
setting will allow less of the larger signal to pass through the
analyzer and the smaller signals peak will then rise out of the noise
floor. Place a delta marker on the smaller signal:

Press [l > 1 > kHz

Press [5N

Press > Delta > Delta (On)
Press 50 > kHz

Figure 3-8  Resolved small signal from large signal
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The 1 kHz filter shape factor of 15:1 has a bandwidth of 15 kHz at
the 60 dB point. The half-bandwidth (7.5 kHz) is narrower than the
frequency separation of 50 kHz, so the input signals can be
resolved.
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Measuring a Low-Level Signal

This section provides information on measuring low-level signals
and distinguishing them from spectrum noise.

Reducing Input Attenuation

The ability to measure a low-level signal is limited by internally
generated noise of the spectrum analyzer. The analyzers input
attenuator affects the level of a signal passing through the
analyzer. If a signal power level is close to the noise floor, reducing
the analyzer input attenuation will help raise the signal so that it
can be seen rising out of the noise.

Ensure that the total power of all input signals at the analyzer RF
input does not exceed +30 dBm (1 Watt).

1  Preset the analyzer
Press &5 > Preset (With Preset Type of Factory)

System

2 Set the source frequency to 300 MHz, amplitude to =70 dBm.
Connect the source RF OUT to the analyzer RF IN.

Figure 3-9  Setup for obtaining one signal
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Set the center frequency, span and reference level:
Press > Center Freq > 300 > MHz

Press > Span > 2 > MHz

Press > Ref Level > 40 > -dBm.

Move the desired peak to the center of the display:
Press (55

Search

Press > Mkr -> CF

Reduce the span to 500 kHz, if necessary re-center the peak:
Press > 500 > kHz

Set the attenuation to 20 dB:

Press > Attenuation > 20 > dB

Figure 3-10 Asignal closer to the noise level

00 dBEm #Atten 20 dB

i |‘
\M“Iu\lef\"‘ﬁ "q w"u".“p‘u,-,n";!'-‘,,"‘.'\ Y \I\~'y,‘t.'\‘\"if\l‘u,l‘,l\\\,{Wﬁ\W‘u"

“»’»"'ﬂ'n.v""’%J‘.,v'“ﬂ"1““qr-w“uﬂﬂ “J|WJk‘.*"'.’“"-‘ﬂ”nl.n'n"\w¥~.l\’

Note that increasing the attenuation moves the noise floor closer to
the signal level.

To allow more of the signal power to pass through the analyzer,
decrease the attenuation to 0 dB.
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A lower attenuation value will mean that more of the signal
strength will be displayed on screen:

Press > Attenuation > 0 > dB
Figure 3-11 Measuring a low-level signal using O dB Attenuation
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Decreasing the Resolution Bandwidth

Resolution bandwidth settings affect the level of internal noise but
have little affect on the displayed level of continuous wave (CW)
signals. Decreasing the RBW by a decade (factor of ten) reduces
the noise floor by 10 dB.

1 Refer to the procedure "Reducing Input Attenuation" on page 41
and follow steps 1, 2 and 3.

2  Decrease the resolution bandwidth:

Press and

The low-level signal appears more clearly due to the noise level
being reduced by the decrease in RBW (see Figure 3-12).
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Figure 3-12 Decreasing Resolution Bandwidth
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A “#” mark appears next to the Res BW annotation in the lower left
corner of the screen, indicating that the resolution bandwidth is
uncoupled.

Uncoupled indicates that the function is in manual control mode,
not auto control mode. Manual control mode allows the user to
change the parameter value for that function without affecting any
other settings.

The analyzer allows you to change the RBW in a 1-3-10 sequence
by the data control keys. The RBWs below 1 kHz are digital and
have a selectivity ratio of 5:1 while RBWSs at 1 kHz and higher have
a 15:1 selectivity ratio. The maximum RBW is 3 MHz and minimum
is 10 Hz.

Trace Averaging

44

Averaging is a digital process in which each sweep of the trace
returns measurement values for each point in the trace. These
values are then mathematically averaged with the previous sweep
trace data which has been stored in the analyzer. The amount of
averaging is selected by choosing the number of trace sweeps to
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be included in the process. The averaging function uses the most
recent trace sweep values so that the display shows any signal
changes.

Selecting averaging, when the analyzer is auto-coupled, changes
the detection mode to Sample, smoothing the displayed noise
level.

This is a trace processing function and is not the same as using the
average detector (as described on page 44).

Refer to the procedure "Reducing Input Attenuation" on page 41
of this chapter and follow steps 1, 2 and 3.

To turn averaging on, toggle the softkey menu labeled Average:

Press > Average (On)

Set the number of averages to 20, using the number keypad, up
and down arrows, or the knob:

Press 20, @

The averaging process smooths the viewed trace, low level signals
become more visible (see Figure 3-13). Changes to the average
number will restart the averaging process.

Figure 3-13 Trace Averaging
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This section provides information on using the frequency counter
function to improve frequency resolution and accuracy.

Press m > Preset (With Preset Type of Factory)
Connect a cable from the front panel CAL OUT to RF IN;

Press > Alignment > Align > CAL OUT ON to toggle on and
enable the 50 MHz amplitude reference signal.

Press hardkey.

The analyzer will detect the signal peak and locate it to the center
of the display screen (Refer to “Auto Tune” on page 94).

Turn the frequency counter on:
Press @ > Function > Freq Counter > Freq Counter (On).

Move the marker, with the front-panel knob, half-way down the
skirt of the signal response.

Figure 3—747_ Using Frequency Counter
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The frequency and amplitude of the marker appears in the active
function area (this is not the counted result). The counted result
appears in the upper-right corner of the display to the right-side of
Cntrl.
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The marker readout in the active frequency function changes while
the counted frequency result (upper-right corner of display) does
not. For an accurate count, the marker need not be placed at the
exact peak of the signal response.

The Frequency counter properly functions only on stable, CW
signals or discrete spectral components. The marker power level
must be greater than 40 dB above the displayed noise level.

To change the counter resolution:
Press > Function > Freq Counter > Resolution

The frequency-counter resolution range is from 1 Hz to 1 kHz, and
may be set to Auto or Manual.

To turn off the marker counter:

Press > Function > Freq Counter > Freq Counter (Off).

When using the frequency counter function, the ratio of the
resolution bandwidth to the span must be greater than 0.02.
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Tracking Drifting Signals
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This section provides information on measuring and tracking
signals that drift in frequency.

Measuring a Source’s Frequency Drift

The analyzer will measure source stability. The maximum amplitude
level and the frequency drift of an input signal trace can be
displayed and held by using the maximum hold function. Using the
maximum hold function you can measure and determine how much
of the frequency spectrum a signal occupies. For more information,
refer to “Max Hold” on page 168.

Use signal tracking to return a signal drifting in frequency to the
center of the display. The drifting is captured by the analyzer using
the maximum hold function.

1  Connect the signal generator to the analyzer RF IN.

2 Output a signal with the frequency of 300 MHz and amplitude of
-20 dBm.

3 Setthe analyzer center frequency, span and reference level.
Press S";ﬁg > Preset. (With Preset Type of Factory)
Press > Center Freq > 300 > MHz
Press > Span > 10 > MHz

Press > Ref Level > -10 > dBm

4  Place a marker on the peak of the signal and turn signal tracking
on:
Press [N

Press > Signal Track (On)
Press > 1> MHz

Notice that this holds the signal in the center of the display.
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Turn off the signal track function:
Press > Signal Track (0ff)

Measure the excursion of the signal with maximum hold:
Press 'ewf > Max Hold

As the signal varies, maximum hold maintains the maximum
responses of the input signal. Annotation on the left side of the
screen indicates the trace mode. For example, M1 S2 S3 S84,
indicates trace 1 is in maximum-hold mode, trace 2, trace 3, and
trace 4 are in store-blank mode.

Activate trace 2 and change the mode to continuous sweep:
Press 'ew/ > Select Trace > Trace 2
Press Clear Write

Trace 1 remains in maximum hold mode to show any drift in the
signal.

Slowly increase the frequency of the signal generator. Your
analyzer display should look similar to Figure 3-15.

Figure 3-15 Viewing a Drifting Signal With Max Hold and Clear Write
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Making Distortion Measurements

This section provides information on measuring and identifying
signal distortion.

Identifying Analyzer Generated Distortion

High-level input signals may cause analyzer distortion products
that could mask the real distortion measured on the input signal.
Use trace and the RF input attenuator to determine which signals,
if any, are internally generated distortion products.

In this example, we use the RF output of a signal generator to
determine whether the harmonic distortion products are internally
generated by the analyzer.

1  Connect the signal generator to the analyzer RF IN.
2  Set the source frequency to 200 MHz, amplitude to O dBm.
3 Setthe analyzer center frequency and span:

Press [§F) > Preset

Press > 400 > MHz

Press > 500 > MHz

Figure 3-16 Harmonic Distortion
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The signal produces harmonic products (spaced 200 MHz from the
original 200 MHz signal) in the analyzer input mixer as shown in
Figure 3-16.

Change the center frequency to the value of the first harmonic:
Press B3 > Next Peak

Press > Mkr -> CF

Change the span to 50 MHz and re-center the signal:

Press > 50 > MHz

Press g6

Search

Press > Mkr -> CF
Set the attenuation to O dB:
Press > Attenuation > 0 > dB

To determine whether the analyzer generates harmonic distortion
products, first display the trace data in trace 2 as follows:

Press P38 > Select Trace > Trace 2

Trace

Press Clear Write

Allow trace 2 to update (minimum two sweeps), then store the data
from trace 2 and place a delta marker on the harmonic of trace 2:
Press BN > View

Press R$5

Search

Press > Delta > Delta (On)

The analyzer display shows the stored data in trace 2 and the
measured data in trace 1. The MarkerA indicator reads the
difference in amplitude between the reference and active markers.

Increase the RF attenuation to 10 dB:
Press > Attenuation > 10 > dB
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Notice the MarkerA amplitude readout. This is the difference of the
distortion product amplitude between 0 dB and 10 dB input
attenuation settings. If the MarkerA absolute amplitude is
approximately =1 dB for an input attenuator change, the analyzer
is generating, at least in part, the distortion.

00 dBm  #Atten 10 dB
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The MarkerA amplitude readout comes from two sources:

1) Increased input attenuation causes poorer signal-to-noise ratio.
This causes the MarkerA to be positive.

2) The reduced contribution of the analyzer circuits to the harmonic
measurement causes the MarkerA to be negative.

Large MarkerA readout indicates significant measurement errors.
Set the input attenuator to minimize the absolute value of MarkerA.
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Third-Order Intermodulation Distortion

Two-tone, third-order intermodulation distortion is a common
specification in communication systems. When two signals are
present in a non-linear system, they may interact and create
third-order intermodulation distortion (TOI) products that are
located close to the original signals. System components such as
amplifiers and mixers contribute to the generation of these
distortion products.

For an example of the quick setup of TOl measurement, refer to
“Intermod (TOI)” on page 130.

This example will test a device for third-order intermodulation
through the use of markers. Two sources are used, one set to 300
MHz and the other to 301 MHz.

1  Connect the equipment as shown in figure below. This combination
of signal generators, low pass filters, and directional coupler (used
as a combiner) results in a two-tone source with very low
intermodulation distortion. Although the distortion from this setup
may be better than the specified performance of the analyzer, it is
useful for determining the TOI performance of the source/analyzer
combination. After the performance of the source/analyzer
combination has been verified, the device-under-test (DUT) (for
example, an amplifier) would be inserted between the directional
coupler output and the analyzer input.

Signal Generator Signal Generator Spectrum Analyzer

i

goggdooy
[IE(E[E
[EIE(E[E

® OOBEE
o
—

© 00ED

I

RFIN

300 MHz LOW
PASS FILTER

300 MHz LOW
PASS FILTER

Directional Coupler
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The coupler should have a high degree of isolation between the
two input ports so the sources do not intermodulate.

2 Setone source (signal generator) to 300 MHz and the other source
to 301 MHz, for a frequency separation of 1 MHz. Set the sources
equal in amplitude as measured by the analyzer (in this example,
they are set to -5 dBm).

3 Setthe analyzer center frequency and span:
Press ls’gfgg > Preset (With Preset Type of Factory)
Press > Center Freq > 300.5 > MHz
Press > 5> MHz

4  Reduce the RBW until the distortion products are visible:
Press and

5 Move the signal to the reference level:
Press 355

Search

Press > Mkr -> Ref Lvl
6 Reduce the RBW until the distortion products are visible:

Press and

7 Activate the second marker and place it on the peak of the
distortion product (beside the test signal) using the Next PeaK:

Press > Delta > Delta (On)

Press BELS > Next Peak

Search
8 Measure the other distortion product:

Press jyetie > Normal

Press BN > Next Peak

Search
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Measure the difference between this test signal and the second
distortion product (see Figure 3-17):

Press > Delta > Delta (On)
Press E > Next Peak

Figure 3-17 Measuring the Distortion Product
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Measuring Phase Noise

Phase noise is a frequency domain measure of stability. Phase
noise is specified as single-sideband power in relation to the
fundamental RF output frequency. It is measured at various offset
frequencies from the carrier, normalized to a 1 Hz measuring
bandwidth.

In this example the 50 MHz amplitude reference signal is used as
the fundamental signal.

1 Press Eerﬁ > Preset (With Preset Type of Factory)
2  Connect a cable from the front panel CAL OUT to RF IN.
Press [ > Alignment > CAL OUT On
3 Press to auto-tune the signal to the center of display.
4 Press to place a marker on the peak of the signal.
5 Turn on the phase noise function to view the results:
Press @ > Function > Phase Noise > Phase Noise (On)
6 Change the offset:
Press @ > Function > Phase Noise > Offset Manual

Then select the offset by pressing the corresponding softkeys
under the Phase Noise menu.

.61 dBm  Atten 10 dB
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Stimulus Response Transmission

The procedure below describes using the built-in tracking
generator of the analyzer to measure the rejection of a low pass
filter. A type of transmission measurement.

1 To measure the rejection of a low pass filter, connect the
equipment as shown in Figure 3-18. A 370 MHz low pass filter as
the DUT.

Figure 3-18 Transmission Measurement Test Setup

DUT

2  Press &5 > Preset. (With Preset Type of Factory)

System
3  Set the start and stop frequencies and resolution bandwidth:
Press > Start Freq > 100 > MHz
Press > Stop Freq > 1 > GHz
Press f#48 > Res Bw > 3 > MHz

4 Turn on the tracking generator and if necessary, set the output
power to -10 dBm:

Press > Tracking Generator > Amplitude TG (On) > -10 > dBm

Excessive signal input may damage the DUT. Do not exceed the
maximum power that the device under test can tolerate.
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To reduce ripples caused by source return loss, use 6 dB or greater
output attenuation. Tracking generator output attenuation is
normally a function of the source power selected. However, the
output attenuation may be controlled in the Tracking Generator
menu.

To increase measurement sensitivity and smooth the noise:
Press 448 > Res Bw > 30 > KHz

Press > Video Bw > 300 > KHz

A decrease in displayed amplitude is caused by tracking error.

Use peak tracking to correct the frequency offset:

Press m > Tracking Generator > More > Tracking Peak

Tracking error occurs when the output frequency of the tracking
generator is not matched to the input frequency of the analyzer.
The amplitude should return to the value that was displayed prior
to the decrease in resolution bandwidth.

Connect the cable from the tracking generator output to the
analyzer input. Store the frequency response in trace 3 and
normalize:

Press m > Tracking Generator > More > Normalize > Store Ref (1
— 3) > Normalize (On)

Reconnect the DUT to the analyzer and change the normalized
reference position:

Press m > Tracking Generator > More > Normalize > Norm Ref
Posn > 8
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Measure the rejection of the low pass filter:
Press > Normal > 370 > MHz, Delta > 160> MHz

The marker readout displays the rejection of the filter at 160 MHz
above the cutoff frequency of the low pass filter. See Figure 3-19
as below.

Figure 3-19 Measure the Rejection Range

Atten 20 dBE

WEBW 10.00 kHz
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Measuring Stop Band Attenuation of a Lowpass Filter

When measuring filter performance, it is useful to look at the
stimulus response over a wide frequency range. Setting the
analyzer y-axis (amplitude) to Log scale type presents the
measurement data in a usable format for determining filter
characteristics.

The following example uses the tracking generator to measure the
stop band attenuation of a 370 MHz low pass filter.

1  To measure the response of a low pass filter, connect the
equipment as shown in Figure 3-20. This example uses a
370 MHz low pass filter.

Figure 3-20 Transmission Measurement Test Setup

0OBBE
PEEE
ODEREL

®0060

[ DUT |—

2  Press [ > Preset. (With Preset Type of Factory)

System
3  Set the start and stop frequencies and resolution bandwidth:
Press > Start Freq > 100 > MHz

Press > Stop Freq > 1 > GHz
Press > Scale Type > Log
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Set the resolution bandwidth to 10 kHz:
Press > Res Bw > 10 > KHz

Excessive signal input may damage the DUT. Do not exceed the
maximum power that the device under test can tolerate.

Turn on the tracking generator and, if necessary, set the output
power to -10 dBm:

Press m > Tracking Generator > Amplitude TG (On) > -10 > dBm

Connect the test cable (but not the DUT) from the tracking
generator output to the analyzer input. Store the frequency
response into trace 3 and normalize:

Press pi&y > Tracking Generator > More > Normalize > Store Ref (1
— 3) > Normalize (On)

Reconnect the DUT to the analyzer. Note that the units of the
reference level have changed to dB, indicating that this is now a
relative measurement.

To change the normalized reference position:

Press m > Tracking Generator > More > Normalize > Norm Ref
Posn > 8

Place the reference marker at the specified cutoff frequency:
Press M > Delta Pair (Ref) > 370 > MHz
Place the second marker at 37 MHz:

Press > Delta Pair (Delta) > 37 > MHz
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1

12

In this example, the attenuation over this frequency range is -17.98
dB/octave (one octave above the cutoff frequency).

Use the front-panel knob to place the marker at the highest peak in
the stop band to determine the minimum stop band attenuation. In
this example, the peak occurs with Delta of 563 MHz. The
attenuation is -60.93 dB. See Figure 3-21.

Figure 3-21 Minimum Stop Band Attenuation

Atten Z0 dB
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Making a Reflection Calibration Measurement

The following procedure makes a reflection measurement using a
coupler or directional bridge to measure the return loss of a filter.
This example uses a 370 MHz low pass filter as the DUT.

The calibration standard for reflection measurements is usually a
short circuit connected at the reference plane (the point at which
the device under test (DUT) is connected.) See Figure 3-22, a short
circuit has a reflection coefficient of 1 (0 dB return loss). It reflects
all incident power and provides a convenient O dB reference.

1  Connect the DUT to the directional bridge or coupler as shown in
Figure 3-22. Terminate the unconnected port of the DUT.

Figure 3-22 Reflection Measurement Short Calibration Test Setup

— [ @Es I}
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§ : DUT
Directional
Bridge/Coupler Test Port

For greatest accuracy, use a coupler or bridge with the correct test
port connector. Any additional adapters or components placed
between the test port and DUT degrades coupler/bridge directivity
and system source match.

For best results, use the same adapter for the calibration and the
measurement. Be sure to terminate the second port of a two port
device.
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Connect the tracking generator output of the analyzer to the
directional bridge or coupler.

Connect the analyzer RF input to the coupled port of the
directional bridge or coupler.

Press g’?ﬁm > Preset. (With Preset Type of Factory)

Turn on the tracking generator and, if necessary, set the output
power to -10 dBm:

Press m > Tracking Generator > Amplitude TG (On) > -10 > dBm

Excessive signal input may damage the DUT. Do not exceed the
maximum power that the device under test can tolerate.

Set the start and stop frequencies and resolution bandwidth:
Press > Start Freq > 100 > MHz

Press > Stop Freq > 1> GHz

Press > Res Bw > 3 > MHz

Replace the DUT with a short circuit.

Normalize the trace:

Press By > Tracking Generator > More > Normalize > Store Ref (1
— 3) > Normalize (On)

This activates the trace 1 minus trace 3 function and displays the
results in trace 1 (Figure 3-23). The normalized trace or flat line
represents O dB return loss. Normalization occurs each sweep.
Replace the short circuit with the DUT.

The reference trace is stored in trace 3, changing trace 3 to Clear
Write will invalidate the normalization.
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Figure 3-23 Short Circuit Normalized

Atten 20 dB
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Measuring Return Loss Using the Reflection Calibration
Routine

This procedure uses the reflection calibration routine in the
proceeding procedure "Making a Reflection Calibration
Measurement" on page 63 to calculate the return loss of the 370
MHz low pass filter.

1  After calibrating the system with the above procedure, reconnect
the filter (DUT) in place of the short circuit used for calibration. Do
not change any of the analyzer settings or the measurement setup
may be invalidated.

2 Use the marker to read return loss. Position the marker with the
front-panel knob to read the return loss at that frequency.

Rotate the knob to find the highest peak and the readout is the
maximum return loss. See Figure 3-24.

Figure 3-24 Measuring the Return Loss of the Filter

Mkr2
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Making an Average Power Measurement

Average power measurements provide a key metric in transmitter
performance.

Base station transmit power must be set accurately to achieve
optimal coverage in wireless networks. If the transmit power is set
too high due to inaccurate power measurements, undesired
interference can occur. If the transmit power is set too low,
coverage gaps or holes may occur. Either case affects system
capacity and may translate into decreased revenue for service
providers. Average power can be measured for the channel of
interest while the base station is active. All other channels should
be inactive. Average power is a broadband measurement. If other
signals are present the analyzer will also measure their power
contributions.

The maximum power for the RF IN port and the RF OUT port of the
analyzer is +30 dBm (1 W). The maximum power for the U2000
Series Power Sensor port is +25 dBm (316 mW). When directly
coupled to a base station, the test set can be damaged by
excessive power applied to any of these three ports.

To prevent damage in most situations when directly coupling an
analyzer to a base station, use a high power attenuator between
the analyzer and the BTS.

The N93208B spectrum analyzer supports the U2000 Series USB
POWEr Sensors.

The U2000 Series USB power sensors do not need manual
calibration and zero routines performed. Calibration and zeroing
are performed without removing the power sensor from the source,
through internal zeroing. With internal zeroing of U2000 Series
USB power sensors, there is no need
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to disconnect the sensor or power-off the DUT. The U2000 Series
do not require 50 MHz reference signal calibration, allowing the
factory calibration to ensure measurement accuracy. For best
accuracy, users are recommended to perform external zeroing for
input signals below -30 dBm for best accuracy.

If you suspect other signals may be present, it is recommended
that you turn off all the other channels and measure average power
only on the signal of interest. Another option is to measure channel
power (which is less accurate), that filters out all other channels
(signals).

Connect the power meter as close as possible to the power
amplifier/duplexer output. Do not use a coupled port. Sensors may
not be as accurate at the power levels provided by coupled ports.

Making a Basic Average Power Measurement

68

To make an average power measurement, you connect the power
sensor and cable, zero and calibrate the meter, before making a
measurement. Zeroing of the power meter will occur automatically:

Every time you use the Power Meter.

When a 5 degree C. change in temperature occurs.
Whenever you change the power sensor.

Every 24 hours.

Before measuring low level signals—for example, 10 dB above
the lowest specified power for your power sensor.

Calibrating the power meter every time you cycle the power on and
off.

In most situations, you can press {Zero} to complete the two steps
(zero and cal) together.
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To Make a Basic Average Power Measurement

Follow the steps below to make a basic average power
measurement.

Press B4&5A > Preset. (With Preset Type of Factory)

System

Press RO, rotate the knob or press the arrow hardkey to highlight
Power Meter, then press [ENTER] to turn on the power meter.

Zero and calibrate the meter. Press {Zero} to make a Zero operation
of the power sensor followed by a calibration operation.

Connect the power sensor to the power Ref 50 MHz port. The
analyzer supports the U2000 Series power sensors.

Connect the external attenuation, if required, with the power
sensor used.

Connect the analyzer to the base station. Connect the power
sensor to the signal to be measured. A typical BTS connection is
after the output of the power amplifier and duplexer. The
connection requires a 2 ft. cable and two Type-N barrel
connectors, in addition to the power sensor and external
attenuator.

Figure 3-25 Connection with base station
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Setting Power Meter Resolution

You can choose from four levels of Power Meter resolution. Higher
resolutions provide more accuracy but slow the measurement
speed.

Press f&34 > Preset. (With Preset Type of Factory)

System
Press [, rotate the knob or press the arrow hardkey to highlight
Power Meter, then press [ENTER] to turn on the power meter.

Press {Meas Disp} > {Resolution}. Select 1,2,3 or 4. The four options
represent different resolution as follow:

1=

[1
[2] =
[3]1=0.01
[4] = 0.001

Setting the Power Meter.s Top and Bottom End-Points

Setting the end points (Disk Range) close to expected
measurement value changes the sensitivity of the Power Meter
scale resolution. This is an advantage in viewing small changes in
power. However, this will not affect the overall range of the sensor.

Press :m > Preset. (With Preset Type of Factory)

Press [, rotate the knob or press the arrow hardkey to highlight
Power Meter, then press [ENTER] to turn on the power meter.

Press {Meas Disp} > {Dis Range} to access the end-points menu.

Press {Top} and enter the maximum scale value using the numeric
keypad. Then press {dBm} to complete the setup.

Press {Bottom} and enter the minimum scale value desired using
the numeric keypad. Then press {dBm} to complete the setup.
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Demodulate the AM/FM signal

The N93208B provide you the AM/FM demodulation function.

Demodulating an AM Signal

The demodulation functions listed in the menu under >
{Demod} allow you to demodulate and hear signal information
displayed on the analyzer.

Simply place a marker on a signal of interest, set the analyzer in
zero span, activate AM demodulation, turn the speaker on, and
then listen.

1 Press g;ﬁ'{l > Preset. (With Preset Type of Factory)

2 Connect an antenna to the analyzer input.

3 Selectafrequency range on the analyzer, such as the range for AM
radio broadcasts. For example, the frequency range for AM
broadcasts in the United States is 550 kHz to 1650 kHz:

Press >{Start Freq}> 550 > {kHz} > {Stop Freq} > 1650>{kHz}.
4 Place a marker on the signal of interest:
Press [5iM > {Next Pk Right} or {Next Pk Left}
5 Set the frequency of interest to center frequency:
Press > {Next Pk Right} or {Next Pk Left} (as necessary).
6 Change the resolution bandwidth to 100 kHz:
Press > 100 > {kHz}.
7 Press > {Zero Span}.
8 Set the detector type and turn on AM demodulation:
Press B8 > {Detector} > {Sample}.

Display

Press > {Demod} > {AM ON}.
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Demodulating an FM Signal
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This section demonstrates how to demodulate and listen to an FM
signal using the built-in FM demodulator.

Using the built in FM demodulator you can tune to an FM signal
and view the results of the detector output as displayed in the
time-domain.

Press B&EEd > Preset. (With Preset Type of Factory)

System

Use a signal source or an antenna for an FM signal to analyze. In
this example the signal source is used transmitting at 300 MHz
with FM deviation of 10 kHz and FM rate of 1 kHz.

If you are using a broadcast FM signal in the United States, for
example, the FM channels are broadcasting between 87.7 MHz to
107.7 MHz.

Set the center frequency to the center of the FM signal (in this case
300 MHz):

Press > 300 > {MHz}.

Set the analyzer to zero span for time-domain analysis:
Press > {Zero Span}.

Press E¥Ed > {Sweep Time} > 5 > {s}.

Press > {Next Pk Right} or {Next Pk Left}

Set the resolution bandwidth to capture the full bandwidth of the
FM signal.

Press > 100 > {kHz}.
Turn on the pre-amplifier to observe the small signal:

Press > {Int Preamp On}.
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Turn on the FM demodulator:
Press >{Demod} > {FM ON}.
Listen to the FM signal.

Press >{Demod} > {Speaker Vol}, rotate the knob to adjust
the speaker volume.

The headphone jack is availabe for the audio signal output
alternatively.
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Analysis the Modulated Signals

The N93208B provides the optional AM/FM (Option AMA) and
ASK/FSK (Option-DMA) modulation analysis function for analysis
the modulated signals. These functions can be activated by license
key.

AM/FM Modulation Analysis

74

Optional AM/FM demodulation analysis provides modulation
metrics, including carrier power, modulation rate, AM depth/FM
deviation, SINAD and carrier frequency offset. User definable limits
provide Pass/Fail indicators of four types:

Maximum carrier power, Maximum AM modulation index or FM
deviation, Minimum AM modulation index or FM deviation, and
Minimum carrier frequency offset.

The user can save the waveforms with metrics for reporting as well
as the set-up parameters for future measurements or analysis. In
the following example, you can use any source available (such as
AM/FM radio) as long as it has AM/FM signal generation
capability.

AM Modulation Analysis
Please refer to the procedures below for the AM modulation
analysis:

1 Connect the signal generator to RF IN connector and turn on
the signal generator’'s AM and RF output.

2 Turn on the AM demodulation analysis function.

Press [MODE], Rotating the knob to highlight AM modulation
Analysis, press [ENTER].

3 Press {Carries Freq} > [500] > {MHz} to set the carrier frequency.
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4 Set the attenuation state to Auto (default):
Press {More} > {More} > {Attenuation Auto} > {More}

5 Press {Y Scale} > {Auto Scale} > {Return} to set the Y scale.

6 Set the AM depth limit and turn on the limit function:
Press {More} > {Limits} > {AM Depth UP} > [76] > {%} > {AM
Depth Low} > [70] > {%} > {Limits on}
The red value in the result indicates the demodulated AM depth
exceeds the limits set as above.

Figure 3-26  AM demodulation analysis

| Att: o.00dB CarrFreg: 500.000000MHz

FM Modulation Analysis

Please refer to the procedures below for the FM modulation
analysis:

1 Connect the signal generator to RF IN connector and turn on
the signal generator’'s FM and RF output.

2 Turn on the FM demodulation analysis function.

Press [MODE], rotating the knob to highlight FM modulation
Analysis, press [ENTER].

3 Press {Carries Freq} > [1.5] > {GHz} to set the carrier frequency.
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4 Setthe attenuation state to Auto (default):

Press {More} > {More} > {Attenuation Auto} > {More}

5 Press {Y Scale} > {Auto Scale} > {Return} to set the Y scale.

6 Setthe FM deviation limit and turn on the limit function:
Press {More} > {Limits} > {FreqDev UP} > [60] > {%} > {FreqDev
Low} > [30] > {%} > {Limits on} > {Return}

The purple value in the result indicates the demodulated FM
deviation exceeds the limits set as above.

Figure 3-27  FM modulation analysis

Att: 0.00cdB CarrFreg: 1.50000000GHz
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ASK/FSK Modulation Analysis

The ASK/FSK modulation analysis function supports four display
modes:

Symbol
Waveform
ASK/FSK Error
Eye Diagram.
User definable limits provide Pass/Fail indicators of four types:
Maximum carrier power
Maximum ASK modulation depth/FSK frequency deviation
Minimum ASK modulation depth/FSK frequency deviation
Maximum carrier frequency offset.
The metrics includes carrier power, ASK/FSK error, ASK depth/FSK
frequency deviation, and ASK index etc. The waveform with metrics

and setup parameters can be saved for reports and future
Measurements.

In the following example, you can use any source available (such as
your remote key of the car) as long as it has ASK/FSK generation
capability. For ASK/FSK signal, its Filter is Nyquist and Alpha is
0.35.

ASK Modulation Analysis
Please refer to the procedures below to analysis the ASK
demodulation.

1 Connect the signal generator to RF IN connector and turn on
the signal generator’'s ASK and RF output.

2 Turn on the ASK demodulation analysis function.

Press [MODE], rotating the knob to highlight ASK modulation
Analysis, press [ENTER].

3 Press {Carries Freq} > [100] > {MHz} to set the carrier frequency.
4 Press {Symbol Rate} > [10] > {MHz} to set the symbol rate.
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Press {Filter Setup} > {Ref Filter} > {Nyquist} > {Return} to set the
filter type.

Set the attenuation state to Auto (default):
Press {More} > {More} > {Attenuation Auto} > {More}

7 Press {Y Scale} > {Auto Scale} > {Return} to set the Y scale.
8 Setting the ASK depth limit and turn on the limit function:

Press {More} > {Limits} > {ASK Depth UP} > [71] > {%} > {ASK
Depth Low} > [70] > {%} > {Limits on} > {Return}

Press {More} > {More} > {View} > {Eye Diagram} to view the eye
diagram.

FSK Demodulation Analysis

Please refer to the procedures below to analysis the FSK
demodulation.

1

Connect the signal generator to RF IN connector and turn on
the signal generator’s FSK and RF output.

Turn on the ASK demodulation analysis function.

Press [MODE], Rotating the knob to highlight FSK modulation
Analysis, press [ENTER].

3 Press {Carries Freq} > [1.5] > {GHz} to set the carrier frequency.
4 Press {Symbol Rate} > [10] > {ksps} to set the symbol rate.
5 Press {Filter Setup} > {Ref Filter} > {Nyquist} > {Return} to set the

filter type.

Set the attenuation state to Auto (default):

Press {More} > {More} > {Attenuation Auto} > {More}

Press {Y Scale} > {Auto Scale} > {Return} to set the Y scale.
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8 Setting the FSK deviation limit and turn on the limit function:
Press {More} > {Limits} > {FreqDev UP} > [85] > {kHz} > {FreqDev
Low} > [80] > {kHz} > {Limits on}

The figure below indicates the FSK EYE Diagram as a measurement
result.

Figure 3-28  FSK Eye Diagram

| Att: 0.00dB CarrFreq: 1.50000000GHz
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FSK Error: 16.08% 66.103% 1.439%

Mag Error: 0.52% 60.93% 0.17%
Carr Freq Offset: 202.632kHz 202.632kHz -197.392kHz
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Channel Power measures the power and power spectral density in
the specified channel bandwidth. A white frame on the display
indicates the edge limits of the channel bandwidth. The user must
specify the center frequency, reference level, and channel
bandwidth to be used for the measurement.

The power calculation method used to determine the channel
power is a traditional method known as the integration bandwidth
(IBW) method. A swept spectrum is used as the basis for this
calculation. Therefore, it is important to set the resolution
bandwidth correctly before making this measurement using the
following formula:

RBW = (k(span))
n

Please refer to the procedures below to set a channal power
measurement.

Press > Channel Power to select the channel power
measurement mode.

Press 'Enter’ to continue Heasure Off

Channel Power

Channel Power
Occupied BHW
ACP

Intermod Occupied BA

Spectrun Emission Mask

ACPR

Intermod

SEN
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2 Press Standard Customize in the submenu to choose the radio
stadard.

Ch Freq 1. 500000000GHz Trig: Free

Charnel Power

Fa
Wy KR

WATR
2. 00000Hz

{ZERR
3. 000000HHz

Lk S
1. 500000006 Hz

3 There are four wireless standard options: WCDMA, CDMA, LTE,
GSM. Press WCDMA as an example.

Ch Freg 1. 500000000GHz Thnig: Free Customi ze
Channel Power
WCDNA
CORAZ000
GSHl
LTE»
&Rl

Once the standard is set, the integration bandwidth and span will
be automatically set according to the standard.
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4  Press Center Freq to change the center frequency of the current
signal channel. Adjust the center frequency to measure other

channel power in the same standard.

Ch Freg 1.500000000GHZ
Channel Power

FVEH 300.0kHz

HOHRE
5. 00000NHz

{ZEAR
7. 500000HHz

L
1. 500000006Hz

Standarde
WCDMA

EE

Please follow the similar procedure as above to measure the

channel power in the CDMA and LTE standard.

To measure the channel power in GSM standard, the default
setting is 10 MHz span, 300 kHz RBW, and the continuous peak
search is enabled. The instrument will measure the channel power

after the center frequency is changed.
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Viewing Catalogs and Saving Files

The analyzer will store and retrieve data files similar to using a PC.
The analyzer allows you to view and save files in the internal
storage of the analyzer or to a USB storage device. This section
provides information on how to locate catalogs (file types) and to
save files.

Locating and Viewing Files in the Catalog

State
Trace
Screen
Limits

The analyzer has four types of files:

stores analyzer settings (file extension: .STA).

stores trace information (file extension: .TRA).

stores screen captures of the display (file extension: .JPQ).

which stores data sets to determine whether a trace has exceeded
preset specifications (file extension: .LIM).

Trace files are not bitmap files. They cannot be imported into other
applications or converted. If you require the use of other
applications, be sure to save as .JPG formats using Screen for your
file type.

Press ﬁ > Catalog to bring up a screen display below.

Catalog
Name: [statezZ2 STA|
Tupe: State

Path: ush

Name Type Size
stateZ22 STH 52172
stateZ23 STH 521T.

stateZ2q STA 52172 30/10/08 15:12:09
statez25 STA 52172 30/10/08 15:12:10

Used: 112263 kB Free: 417071 kB

fush/STATE223.5TA file saved

83



Functions and Measurements
Viewing Catalogs and Saving Files

1 The entry fields show the parameters for the files viewed:
Name states the filename.
Type displays the type of files viewed.
Path displays the location of the files (Local or USB).
2 There are four column headings in this area of the display:
Name displays the filename.
Typedisplays the filename extension (TRA, STA, TRC or JPG).
Sizedisplays the size of the file in bytes.
Modified displays the date and time the change occurred.
3 The softkey menu has four options:
Type selects the type of file you wish to view.
Sort sorts and views the files according to a file attribute.
Local accesses the internal storage to view files.
USB accesses the external USB storage device to view files.

4 The drive space line shows the number of bytes used on the drive
and the number of bytes still free on the drive.

Saving a File

The analyzer can save files (states, traces, limits or screens) to a
USB storage device (USB/), or internal storage (Local/). The
following is an example of how to save a trace to internal storage
(Local/).

1  Select the save destination for the file. This example will select the
internal storage (Local/):

Press > Catalog > Local
Press Return > Save, to access the Save menu.

Select the type of file. In this example we will save a trace. The
filename extension for the trace file type is .TRA:

Press Type > Trace
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Select the trace to save (1, 2, 3, 4 or all traces). For this example,
we will select trace 3:

Press Source > Trace 3

Enter a filename by pressing Name. Assume you name the file
“TEST1”. The alpha portion of the filename is selected using the
softkey menus. The numeric keypad is used for the numeric portion
of the filename. Press to accept the filename and to
terminate this process and return to the Save menu.

The filename can be composed of alpha (A-Z) or numeric (0-9)
characters in any combination. The analyzer will not overwrite an
existing file. If the filename already exists, the status bar will display
the message: “File already exists”. If a filename is not edited, the
analyzer will automatically generate a name based on the type of
file you are saving (State: STATE, Trace: TRACE, Limits: LIMIT,
Screen: SCREN). It also generates a three digit integer, starting at
000 and extending through 999, which it adds to the name, for
example: TRACE056.TRC. The analyzer will remember the previously
saved value even through a power cycle.

Press Save Now to save the file.

“Saving Now” is displayed during this operation. In this example, the
status bar displays “Local/TEST1.TRC file saved”.

When saving a file to a USB storage device, do not disconnect the
USB device during the save operation. To do so may cause
unexpected data loss.
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Loading a File

86

This feature will recall (load) onto the displayed screen a previously
saved filename and type compatible with this analyzer. The file
types are described above.

Select the directory where your file is located. In this example,
select the internal storage (Local/):

Press > Catalog > Local

Press Return > Load to access the Load menu

Select the type of file. Assume you need to load a trace file:
Press Type > Trace

Using the knob or arrow keys to highlight the file you need. And
then select the trace into which you wish to load the file. Assume
you need to load file TEST1.TRC into Trace 2:

Press Destination > Trace 2.

Press Load Now to load the specified file. The status bar displays:
“Local/TEST1.TRC file loaded”.

Screen files are in .jpg format and cannot be loaded or recalled into
the analyzer display, they can only be downloaded and used in PC
applications.
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Copying a File
To copy a file from internal storage to a USB storage device, follow
this procedure:
1 Press > Catalog > Local to select the path.
2  Connect a USB storage device to the USB connector (DEV).
Select the type of file. Assume you need to copy a trace file:
Press Return > Copy > Type > Trace

4 Using the knob or arrow keys to highlight the file name you need. In
this example, highlight the file TEST1.TRC.

5 Press Copy Now to execute the operation. A “Copying file” indicator
displays. Then “/USB/TEST1.TRC file copied” appears on the status
bar. You have now copied the file TEST1.TRC from the internal
storage to the USB storage device.

Deleting a File

Perform the following process to delete a specific file. Note that
once a file is deleted from local memory, it cannot be recovered.

1  Press > Catalog > Local to select the path
2  Press Return > Delete to access the Delete menu

Select the type of file. Assume you need to delete a trace file press
Type > Trace

4 Using the knob or arrow keys to highlight the file name you want to
load. In this example, selecting the file TEST1.TRC.

5 Press Delete Now. “Deleting file” indicates the operation is in
process. Then, “Local/TEST1.TRC file deleted” shown on the status
bar indicates the file has been deleted.
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4 Key Reference

This chapter describes each front panel hardkey and their associated softkeys
(menus). The front panel key descriptions are organized alphabetically. The
lower level softkeys are listed as they appear in the softkey menus.

KEYSIGHT

TECHNOLOGIES
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Ref Level

Attenuation
Auto Man

Scale/Div

Scale Type
Log Lin

Press hardkey to activate the reference level function and
access the amplitude softkey menu.

The softkey menu selections are described as follows:

Sets the reference level. This function is activated when is
pressed. The reference level is the amplitude power or voltage
represented by the top line of the graticule on the display. Setting
the reference level changes the absolute amplitude level (in the
selected amplitude units) of the top graticule line.

Key access:

Toggles the input attenuation between Aute and Man. The
attenuation level can be set in as little as 1 dB increments when
Man is selected. The analyzer input attenuator is normally coupled
to the reference level control, it reduces the power level of the input
signal at the input mixer. Selecting Auto re-couples the attenuator.
Change the attenuation by using the arrow keys, the knob, or the
numeric keypad.

Key access:

Sets the logarithmic units per vertical graticule division on the
display. The Scale/Div function is available only when the Scale
Type key is set to Log.

Key access:

Scales the vertical graticule divisions in logarithmic units when Log
is selected. The valid logarithmic units are 1, 2, 5 and 10 dB per
division. When Lin is underlined, the vertical divisions are linearly
scaled with default amplitude units of volts. The top of the
graticule represents the reference-level value; the bottom of the
graticule represents zero volts. (Each division is one-tenth of the
reference level.)

Key access:



Scale
On Off

Int Preamp
On Off

Y Axis

Ref Lvl Offset

Key Reference
Amplitude

Toggles the amplitude Scale for each graticule. The vertical
divisions are linearly scaled with default amplitude units of volts.
The default unit is dBm. This softkey is only valid when the Scale
Type is set to Lin.

Key access:

(Option PA3) Toggles the internal pre-amplifier function between
on and off. Pressing Int Preamp (0On) results in a correction being
applied to compensate for the gain of the preamp. Amplitude
readings then represent the signal value at the input connector.
When the preamp is on, a “PA” indication appears on the left side of
the display. The preamp operates over a range of 100 kHz to 3
GHz.

Key access:

Accesses the softkeys that change the amplitude units (logarithmic
or linear). Change the amplitude units by pressing dBm, dBmV,
dBuV, dBuA, Watts, Volts, and Amps.

Key access: > More

Adds an offset value to the displayed reference level.
Reference-level offsets are only entered by using the numeric
keypad. Entering an offset does not affect the trace or the
attenuation value. Reference-level offsets are used when gain or
loss occurs between a device under test and the analyzer input.
Thus, the signal level measured by the analyzer may be referred to
as the level at the input of an external amplitude-conversion
device. When an amplitude offset is entered, its value appears on
the left side of the display under Offst (as opposed to frequency
offsets which appear at the bottom of the display). To eliminate an
offset, press Ref Lvl Offset > 0 > dB.

Key access: > More
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Att limit
On Off

Corrections

Ext Amp Gain

Toggles the attenuation limit function between On and Off. When
this softkey is set to On, the reference level will not exceed the
maximum value = (attenuation + 20) dBm.

Key access: > More

Accesses the corrections submenu to enable the corrections
function for amplitude compensation. The amplitude correction is
used to compensate the gain/attenuation from antenna/cable.
Please refer to the procedures below to use the amplitude
correction function.

1 Press [Amplitude] > {More} > {Corrections} to acess the
correction function.

2 Press {Cable/Antenna/0ther/User} to select the corrction type.

3 Press {Edit} to add the point with frequency and amplitude offset
value.

4 When this editing is completed, press {Corrections On} to load
the correction data. The status will be shown on the
corresponding softkey and set the {Apply Corrections} On, the
amplitude compensation will be applied to the displayed trace.

Press {Apply Corrections off} to turn off all the corrections.
Key access: > More

Adds a positive or negative preamplifier gain value, which is
subtracted from the displayed signal. (Use negative values for gain
and positive values for loss.) The function is similar to the Ref Lvl
Offset function, however with the Ext Amp Gain function, the
attenuation may be changed depending on the preamplifier gain
entered. A preamplifier gain offset is used for measurements that
require an external preamplifier or long cables. The offset is
subtracted from the amplitude readout so that the displayed signal
level represents the signal level at the input of the preamplifier. The
preamplifier gain offset is displayed at the top of the screen and is
removed by entering zero. The preamplifier gain offset can only be
entered using the numeric keypad. The preamplifier gain value is
not affected by an instrument preset or a power cycle.

Key access: > More



Impedance
50o0hm 750hm

Key Reference
Amplitude

Toggles the computational input impedance between 50ohm and
750hm. This is only software function in which sets the input
impedance for unit conversions. This set affects the results when
the y axis unit is voltage or current units (dBmV, dB[V, dB[A, V, A)
but does not affect the results when it is power units (dBm, W). The
selected impedance is for computational purposes only, since the
actual impedance is set by internal hardware to 50 ohm.

Key access: > More
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The Auto Tune hardkey activates the autotune function to view the
signal. This hardkey performs the following functions
automatically:

Run Peak Search in full span
Run Mkr -> CF

Select the appropriate reference level according to the amplitude
of searching signal.

Set span to 1 MHz and all auto couple to view the signal.

The Auto Tune function in the frequency range of 5 MHz to 3
GHz. The minimum detectable amplitude is —-65 dBm.

For more information about Peak Search, Mkr ->CF and
Mkr ->Ref Lvl softkeys, refer to "Peak Search" on page 153, and
"Marker->" on page 120.



Back <-

Key Reference
Back <-

The backspace hardkey is located in the numeric keypad area of
the front panel and is used to change or correct an active function
entry, or to change a text entry before you save data to a file.
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Res BW
Auto Man

Video BW
Auto Man

Hardkey activates the resolution bandwidth function and accesses
the softkey menus that control the bandwidth and averaging
functions.

Softkey controls the 3 dB resolution bandwidth of the analyzer
from 10 Hz to 3 MHz using the knob or arrow keys. There are four
available bandwidths less than T KHz are 10, 30, 100 Hz or 300 Hz.
If an invalid bandwidth is entered using the numeric keypad, the
analyzer chooses the closest acceptable bandwidth. As the
resolution bandwidth is decreased, the sweep time is modified in
order to maintain amplitude accuracy. Resolution bandwidth is
also coordinated with the frequency span. As the span is
decreased, the resolution bandwidth decreases. When the
VBW/RBW is set to AUTO, if the resolution bandwidth changes, the
video bandwidth changes to maintain the VBW/RBW ratio.

A “#” mark appears next to “Res BW” on the display when it is not
coupled. To recouple the resolution bandwidth, press Res BW
(Auto).

Key access:

Softkey changes the analyzer post-detection filter from 1 Hz to 3
MHz using the knob or arrow keys. If an invalid bandwidth is
entered, the analyzer chooses the closest available bandwidth. As
the video bandwidth decreases, the sweep time will increase to
maintain amplitude accuracy.

A “#” mark appears next to “VBW” on the bottom of the analyzer
display when it is not coupled. To couple the video bandwidth,
press Video BW (Auto).

Key access:



VBW/RBW
Auto Man

Key Reference

BW/Avg

Sets the ratio between the video and resolution bandwidths. When

a signal is weak and is visually masked by the noise floor, set the

ratio to less than 1 to lower the noise. When the Preset Type is set

to Factory and Preset is pressed, the ratio is set to 1. Change the
ratio by using the arrow keys, knob, or numeric keypad. When

VBW/RBW (Auto) is selected, the ratio is determined automatically

by the rules in Figure 4-1.
Figure 4-1 VBW/RBW Ratio Auto Rules

Is Trace
Average On?

Is Detector peak
or Negative peak?

No

Is Avg Type
Power?

Is Detector
Sample?

Is Avg Type
Power?

Is Trace
Average On?

Key access:
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Average
On Off

Avg Type
Auto Man

Initiates a digital averaging routine that averages the trace points
in a number of successive sweeps resulting in trace “smoothing”.
The number of sweeps (average number) is changeable when
setting Average (Off). Increasing the average number will further
smooth the trace. pressing > Avg Type to select the type of
averaging.

To restart averaging:
Enter a new average number
Change any related parameter (e.g., Center Frequency)

When in sweep single, the specified number of averages is taken,
then the sweep stops and an average trace displayed.

When in continuous sweep mode, the specified number of
averages is taken, then the averaging continues with each new
sweep averaged in with a weight of m and the old

average reduced by multiplying it by Ave,age,\,umbe,_m :

To turn averaging off, press Average (Off).
Key access:

Toggles the average type between automatic and manual.

Selecting Autoe sets the analyzer to automatic averaging by the
rules in Figure 4-2.

Figure 4-2 Auto Rules for Average Type

Is Detector

Average?

Selecting Man sets the analyzer to manual averaging.



EMI Res BW

Sweep Type
Swept FFT
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When trace average is on, the average type is shown on the left
side of the display. Selecting an average type manually causes the
analyzer to use that type without regard to other analyzer settings
and sets Avg Type to Man.

Key access:

Video Avg Video averaging averages the data as appropriate
for the y-axis scale. When Avg Type > Video Avg is
selected, “VAvg” appears on the left side of the
analyzer display if Average is On.

Key access: > Avg Type

Pwr Avg Power averaging is performed by converting the
trace data from logarithmic to linear power units,
and then averaging the power trace data. When
Avg Type > Pwr Avg is selected, “PAvg” appears on
the left side of the screen if Average is On.

Key access: > Avg Type

Press this softkey to select the resolution bandwidth for the
optional EMI filter. This filter provides you with CISPR 16-1-1
bandwidth (200 Hz, 9 kHz, 120 kHz, and 1 MHz).

Key access:

This softkey toggles the Sweep Type between swept mode and FFT
mode. This FFT mode is only available when RBW is set to 1 kHz,
3 kHz, or 10 kHz.

Key access:
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Detector
(detector type)
Auto Man
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Press this hardkey to control detector and display functions.

Softkey presents a submenu to select a specific detector type, or
allows the analyzer to select the appropriate detector (select Auto)
for a particular measurement.

Regarding detectors, it is important to understand what is a trace
“bucket”. For every trace point displayed, there is a finite time
during which the data for that point is collected. The analyzer looks
at all of the data collected during that time and present a single
point of trace data based on the detector mode. The interval during
which the data for that trace point is being collected, is called the
“bucket”.

Figure 4-3 Detector (auto) Selection Flowchart Rules

Phase Res BW
Noise On? >300Hz? Average
No

No
Trace
Average On?

No

0

n
N

Any Trace in
MinHold?

Any Trace in
Max Hold?
No

Any Trace in
Min Hold?

Negative Peak

No

Thus a trace is more than a series of single points. It is actually a
series of trace “buckets”. The data may be sampled many times
within each bucket.
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When the detector is set to Auto, Pressing > Average (On)
changes the detector. The Auto choice will depend on marker
functions, trace functions, and the trace averaging function. If a
marker function or measurement is running, the Aute choice of
detector is either Average or Sample. \When one of the detectors
(such as Average) is manually selected instead of Auto, that
detector is used without regard to other analyzer settings.

Average displays the power average in the bucket.

Sample displays the instantaneous level of the signal at
the center of the bucket represented by each
display point.

Positive Peak displays the max. of the signal in the bucket.

Negative Peak displays the min. of the signal in the bucket.

The detector in use is indicated on the left side of the display. A “#”
will appear next to it if the detector has been manually selected.

Key access:

Auto Selects peak detection as the default. If a different
detection scheme would be better utilized for a
particular measurement, the analyzer will use the
alternate detection method.

Key access: [i#88 > Detector Auto Man

Display
Positive Obtains the maximum video signal between the last
Peak display point and the present display point and stores

this value in memory. It’s used primarily when
measuring sinusoidal components. When Pesitive
Peak is selected, “Peak” appears in the upper-left
corner.

Key access: [l > Detector Auto Man

Negative Is a peak detector, but selects the minimum video

Peak signal value. This detection should not be used to
measure the accurate amplitude. “NPk” also appears
in the upper-left corner, When Negative Peak is
selected.

Key access: [l > Detector Auto Man
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Active Fctn
Position

Display Line
On Off

Average
Video RMS

Sample

Normal

measures the average value of the amplitude across
each trace interval (bucket). When Average is
selected, “Avg” appears on the left corner.

Key access: [if##¥l > Detector Auto Man

Sample detection is used primarily to display noise
or noise-like signals. It should not be used to
measure the accurate amplitude of non noise-like
signals. In sample mode, the instantaneous signal
value of the present display point is placed in
memory. When Sample detection is selected, “Samp”
appears in the upper-left corner of the display.

Key access: [ii#¥ > Detector Auto Man

Selects the maximum and minimum video signal
values alternately. When selecting Nermal detection,
“Norm” appears in the upper-left corner.

Key access: [f##l > Detector Auto Man

Selects the screen position for the Active Function Display.
Depending on the type of trace data being viewed, you can move
the Active Function Display position to minimize its visual
interference with your screen data.

Key access:

Top

Center

Bottom

Displays the active function in the top-left corner of

the display.

Key access: [##l > Active Fctn Position

Displays the active function in the center-left side of
the display.

Key access: |4l > Active Fctn Position

Displays the active function in the bottom-left corner
of the display

Key access: [## > Active Fctn Position

Activates an adjustable horizontal line that is used as a visual
reference line. The line, which can be used for trace arithmetic, has
amplitude values that correspond to its vertical position when
compared to the reference level. The value of the display line



Limits
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appears in the active function block and on the left side of the
display. Use the arrow keys, knob, or numeric keypad to adjust the
display line. Pressing any digit, O through 9, on the numeric keypad
brings up the selected terminator submenu.

Key access:

Accesses softkeys that allow you to control and define the
parameters of limit lines.

Key access:

Limit 1 selects either of the available limits. The Limit 1 and Limit 2
Limit 2 keys access softkeys to set parameters for the selected

limit.

Key access: > Limits

Type defines the limit to be edited as an upper or

Upper lower limit. An upper limit will indicate a fail if

lower trace 1 exceeds this limit. A lower limit will
indicate a fail if trace 1 falls below the limit.
Key access: > Limits > Limit 1/2

Limit Toggles the limit line function to on or off. The

On Off limit points must exist before the limit function

can be turned on. Either Limit or Margin, as
well as Test, must be turned on for a limit test.
Limit points must be defined before the Limit
function can be turned on.

Key access: > Limits > Limit 1/2
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Test
On Off

Margin
On Off

Edit

Toggles the testing of the limit lines between
on and off. If trace 1 is at or within the bounds
of the set limit or margin, “Limit_# Pass” or
“Margin_# Pass” is displayed in the upper left
corner of the measurement area limit line.
Only positive/negative margins are allowed for
lower/upper limits. If the trace is out of the
limit or margin boundaries, “Limit_# Failed” or
“Margin_# Failed” is displayed. Either Limit or
Margin must be turned on for test.

Key access: > Limits > Limit 1/2

Toggles the margin function to on or off. Use
Margin to set a limit line offset for the selected
limit line. Either Limit or Margin as well as Test,
must be turned on for a limit test to work.

Key access: [#i#¥ > Limits > Limit 1/2

Accesses the submenu to edit the limit point,
and also accesses the limits table. Use arrow
keys to move between the rows in the limits
table. New limit segments will only be applied
after close the editor. Pressing Return, or any
key not associated with the editor, will close
the editor.

Key access: [#i#¥l > Limits > Limit 1/2

Point

Creates or edit a limit point. Up to 20 points
can be defined for each limit line. Enter the
point number using the numeric keypad, then
Press [Enter], or use the knob or arrow keys to
move to an existing point.

Key access: > Limits > Limit 1/2 > Edit



Delete
All Limits

Delete Limit
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Frequency

Edits the frequency value for a limit point. After
editing, the limit table will place the frequency
or time in correct order. For a new point, the
Amplitude default is 0 dBm, and Connected
default is Yes.

Key access: > Limits > Limit 1/2 > Edit

Amplitude

Sets the amplitude value for the current point.

Key access: [l > Limits > Limit 1/2 > Edit

Connected To Previous Pt

Defines if the current point being edited is to be
connected to the previous point. Pressing this
key toggles the Connected value between Yes
and No.

Key access: ¢l > Limits > Limit 1/2 > Edit

Delete Point

Deletes the current point in the limit line.
Pressing this key will delete the point
immediately.

Key access: > Limits > Limit 1/2 > Edit

Deletes the current limit set. Pressing this key
will delete the limit line entirely.

Key access: [#i#¥l > Limits > Limit 1/2

Purges data from the limit-line tables. Pressing this key will
delete all the limit line data immediately.

Key access:

Det/ mi
he > Limits
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Enter

Terminates a front-panel keypad numeric entry and enters that
value into the analyzer. (For most applications, it is better to use
the units softkeys to terminate value entry.) When in File menu, the
[Enter] key is used to terminate filename entries.
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Catalog
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Hardkey accesses the softkeys menus to manage the file system of
the analyzer. Refer to "Viewing Catalogs and Saving Files" on
page 83 for more information.

Displays all files located on the selected catalog, depending upon
the preferences set under the Type and Sort keys defined below.

Key access:

Type

selects all types or one type of file(s) for viewing.
Default: State
Key access: > Catalog

All

Screen

State

Trace

Limits

Displays all files and file types on the selected
drive.

Displays only the screen (.JPG) files on the
selected drive.

Displays only the state files (.STA) on the
selected drive. State files contain most
instrument settings.

Displays only trace files ((-TRA) on the selected
drive.

Displays only the limits files (.LIM) on the
selected drive.
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Sort Sorts the files according to a selected file attribute,
including By Date, By Name, and Order Up Down. Order (Up)
sorts files in ascending order (such as A, B, C). Order
(Down) allows you to sort files in descending order (such

asC,BA).
Key access: > Catalog

Local Accesses the internal storage of the analyzer.
Key access: > Catalog

UsB Accesses the external USB storage device.

Key access: > Catalog

Save  Accesses menu keys that allow the user to save the analyzer
screen, state, trace, and limit data to a USB storage device or to
the internal storage.

Key access:

Save Executes the save function. When completed, the
Now message “local (USB)/XXX file saved” (where XXX is the
filename) will appear in the status bar.
Key access: JiZ8 > Save

Print

Type Selects the type of data for the file save.
Key access: f#78 > Save

Print

Screen Displays all previously saved screen files
(.JPG) and captures the current screen
displayed in preparation to save it in a file
(.JPG).

State Displays all saved state (.STA) files and
detects the current state parameters in
preparation to save into a file (.STA). State
files include all settings but not traces or
limits.
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Source

Name

Key Reference
File

Trace Displays all previously saved trace files

(.TRA) and detects the current trace in
preparation to save it in a file (TRA). Save
individual traces or a group of traces.

Limits Displays all previously saved limits files

(.LIM) and detects the current limits in
preparation to save them in a file (.LIM).
Limits provide data sets to determine
whether a trace has exceeded preset
specifications.

When Type is Trace, you can select trace 1,2, 3 or 4 in
addition to the state. All Traces is selected to save all
four traces in a single file, along with the state.

When Type is Limits, Source accesses the Limit 1 and 2
softkeys. Limit 1 and 2 provide data sets to determine
whether a measurement trace has exceeded preset
specifications.

Key access: F#E > Save

Accesses the softkeys to enter the filename.
Key access: B##8 > Save

Print

Only capital letters and digits may appear in file names. The
analyzer will automatically add the three character file
extension name.

Accesses a submenu to load analyzer states, traces and limits into
the analyzer from a USB storage device or internal storage (Local).

Key access:

Load
Now

Type

Executes the load file function. When load
completed, the message “local(USB)/XXX file loaded”
appears in the status bar (where XXX is the filename).
Key access: F > Load

To select the type of file to be loaded.

Key access: [i5M > Load
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Delete

Sort

Destination

State Displays all state file types listed in the
storage location (.STA). Loading a state file
type restores most parameters to the
instrument settings.

Trace Displays all trace file types (.TRA). Load
traces individually or as a group. Loading a
trace also loads the current state, and sets
the trace to view mode.

Limits Displays all limits file types. The limits data
points in these files may help determine
whether a trace has exceeded preset
specifications (.LIM). Limits are loaded
individually only.

Accesses a submenu to view your saved files
according to a selected file attribute. The selections
include, By Date, By Name, and Order Up Down. Order
(Up) sorts files in ascending order (such as A,B,C).
Order (Down) sorts files in descending order (such as
C,BA). -

Key access: [ > Load

Print
With Type set to Trace, Destination directs the data to
Trace 1, 2, 3 or 4. If the data is for all four traces (for
instance, Source was All Traces when they were
saved), the data returns to the original trace
registers.

When Type is set to Limits, Destination allows you to
direct your data to Limit 1 or Limit 2.
Key access: > Load

Print

Enter the submenu for deletion.
Key access:



Copy

Delete
Now

Type

Sort

Key Reference
File

Executes the delete file function. After a successful
delete, the message “local(USB)/XXX file deleted”
appears in the status bar on the display (where XXX is
the filename).

Key access: §#%8 > Delete

Selects the filetype to delete.
Key access: B8 > Delete

Print

All Displays all files for deletion.

Screen Displays only screen files for deletion.
State Displays only state files for deletion.
Trace Displays only trace files for deletion.
Limits Displays only limits files for deletion.

Sorts the files according to a file attribute for deletion:
By Date, By Name and Order Up Down. Order (Up)
displays files in ascending order. Order (Down)
displays files in descending order.

Key access: B > Delete

Print

Enters the submenu to copy files from local to a USB storage

device.

Key access:

Copy
Now

Type

Executes the copy function. If the copy is successful,
“local/XXX file copied to USB” will appear in the status
bar (where XXX is the filename).

Key access: > Copy

Select the type of file to copy.

Key access: > Copy

All Displays all file types.
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Sort

Screen Displays all screen files.
State Displays all state files.
Trace Displays all trace files.
Limits Displays all limits files.

Sorts the files according to a file attribute to be
copied, including By Date, By Name and Order Up Down.
Order (Up) displays files in ascending order. Order
(Down) displays files in descending order.

Key access: > Copy



Frequency

Center Freq

Start Freq

Stop Freq

CF Step
Auto Man

Key Reference
Frequency

Press to activate the center frequency function, and access
the menu softkeys for frequency functions. The center frequency, or
start and stop frequency values appear below the graticule on the
display.

When changing both the center frequency and span, change
the frequency first. The frequency value may limit the span.

Softkey activates the center frequency function and sets the
horizontal center of the display to a specific frequency.

Key access:

Softkey sets the frequency starting at the left side of the graticule.
The left and right sides of the graticule correspond to the start and
stop frequencies.

Key access:

Softkey sets the frequency at the right side of the graticule. The left
and right sides of the graticule correspond to the start and stop
frequencies.

Key access:

Softkey changes the step size for the center frequency function. On
selecting a step size and activating the center frequency function,
the arrow keys change center the frequency by the step-size value.
The step size function is useful for finding harmonics and
sidebands beyond the current frequency span of the analyzer.
Selecting auto-couple sets the center frequency step size to one
division (10 percent of the span).

Key access:
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Freq Offset

Signal Track
On Off

Allows you to input a frequency offset value that is added to the
frequency readout of the marker, to account for frequency co
versions external to the analyzer. Offset entries are added to all
frequency readouts including marker, start frequency, and stop
frequency. Offsets may only be entered using the numeric keypad.
Offsets are not added to the span or frequency count readouts.
Entering an offset does not affect the trace display. When a
frequency offset is entered, its value appears on the bottom of the
display. To eliminate an offset, perform a Factory Preset, or press
Freq Offset, 0, Hz.

When a frequency offset is entered, its value appears on the

bottom of the display (as opposed to reference level offsets, which
appear on the left side of the display). To eliminate an offset, press
Freq Offset, 0, and Enter. Pressing Preset also sets the offset to zero.

Key access:

Softkey moves the signal nearest the active marker to the center of
the display and maintains the signal at the center of the display.
“ST” will appear in the lower-left corner of the display.

Pressing Signal Track (0ff); f&554 > Preset (Preset Type set to

System
Factory); or > All Off will turn off the signal track function.
Toggling signal track to on and reducing the span initiates an
automatic zoom and will reduce the span in steps, so that the
signal remains at the center of the display. Signal track cannot be
activated, if the span is set to zero.

Key access:

If no marker is active, pressing Signal Track (On) activates a
marker, perform a peak search, and center the marker on the
display. Switching to zero span turns Signal Track (Off).



Marker

Select Marker

Normal

Delta

Key Reference
Marker

Hardkey accesses the marker control softkey menus to select the
type and number of markers. Markers are shown on the display as
diamond-shaped characters that identify points of traces. Up to
twelve pairs of markers (when using Delta Pair markers) may
appear on the display simultaneously; only one pair can be
controlled at a time.

Selects one of the twelve possible markers. If a marker has already
been selected it will become the active marker.

Key access:

Activates a single frequency marker at the center of the active
trace if not already displayed.

Displaying a marker before enabling the Nermal function enables
the marker at the position of the selected marker. The marker
number shows above the marker. The knob and/or arrow keys
move the marker left or right. Entering a value from the numeric
keypad moves the marker to the trace point nearest to that value.
Annotation in the active function block and in the upper-right
corner indicates the frequency and amplitude of the marker (time
and amplitude, if in zero span.) Pressing Normal turns off the Delta
function and moves the active marker to the delta marker position.

Key access:

Accesses the submenu to use the marker delta function.
Key access:

Delta Delta (On) activates a second marker at the position

On Off of the first marker. If no marker is present, two
markers with the same identification number will
appear at the center of the display. The marker
number is indicated above the delta marker, and the
same number is indicated with an R (for example, 1R)
above the reference marker. The amplitude and
frequency (or time) of the first marker is fixed.
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Delta Pair
Ref Delta

Span Pair
Span Center

Use the data control keys to position the delta marker.
Annotation in the active function block and in the
upper-right corner indicates the differences between
the two markers, frequency/time and amplitude. Delta
(0ff) moves the reference marker to the active marker
position, allowing you to make delta measurement from
differing reference points without having to turn off the
markers and begin again.

Key access: |t > Delta

Toggles the Delta Pair between the reference (start) and
delta (stop) markers. The start marker number is
indicated with a number and an R (reference) above the
marker (for example, 1R). The delta marker is identified
with the marker number only.

Key access: [yiie > Delta

Toggles the Span Pair function between the span and
center markers. The start marker number is indicated
with a number and an R above the marker (such as 1R)
and the stop marker is indicated with only the marker
number. Adjusting the span changes the frequency
difference between the two markers while maintaining
the midpoint at a fixed frequency. Selecting Center
changes the center point between the two markers
while maintaining the frequency difference.

Key access: [yiie > Delta

Ref and Delta markers maintain their displayed x-axis location,
however, their frequency values will change if the frequency or
span parameters that define the x-axis scale are changed. Reset
these markers, if necessary, when parameters such as Span or
Center Freq are changed.

Off  Turns off the selected marker by the Select Marker key. Off also
turns off the related functions such as signal track. It will also
removes marker annotation from the display.

Key access:



All Off

Function

Key Reference
Marker

Turns off all markers, including markers used for signal track, and
marker annotations.

Key access:

Accesses the marker function softkeys listed below.
Key access:

Freq Accesses the frequency counter function.
Counter  Key access: [Iffi% > Function

Freq Counter Toggles the frequency counter function
On Off on and off.

Resolution Toggles the frequency counter resolution

Auto Man from manual to auto-couple. The allowed
values are 0.1, 1, 10, 100 Hz and 1 kHz.
Pressing Auto auto-couples frequency
counter resolution to the span.

The ratio of the resolution bandwidth to span must be greater than
0.02 for proper frequency counter function. The frequency counter will
work correctly only on CW signals or discrete peaks. For an accurate
reading, the marker must be >40 dB above the noise.

Phase  Accesses the phase noise function softkeys.
Noise  Key access: [yiie > Function

Phase Noise Toggles the phase noise function on and

On Off off.

Offset Manually sets the offset of the marker to
Manual measure phase noise.

Offset Sets the offset to +1, +10, +20, +30, +50,

+100 kHz or +1 MHz.
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Optimize
Phase Noise

This softkey is valid only when span fall in the range of
100 Hz and 100 kHz. After enabling this softkey, the 1st
LO Loop filter bandwidth will be changed from approx. 5
kHz to 120-150 kHz automatically, which optimizes the
phase noise close in to the carrier. For more details on
how to measure the phase noise of a signal, refer to
"Measuring Phase Noise" on page 56.

Key access: & > Function

Optimize Phase noise (On) will worsen phase noise accuracy far
away from the carrier. When testing phase noise far away from the
carrier, select Optimize Phase noise (Off).

Marker Noise Toggles the Marker Noise function between On and Off.

When Marker Noise is set to On, the display Reads out the
average noise level, referenced to a 1 Hz noise power
bandwidth. If no marker is present, a marker appears at
the center of the display. When Marker Noise is enabled
in resolution bandwidths of 1 kHz and above, the auto
coupled detector selection is set to Average and the Avg
Type is set to Power because the trade-off between
sweep time and variance of the result is best with power
Average detection. However, the Marker Noise function
generates appropriately corrected values for all supported
detector modes. If the marker delta function is on and the
noise marker is activated and moved to measure the noise
floor, the marker readout will display the signal-to-noise
ratio.

You can use Delta and Marker Noise to indicate noise level relative
to sinusoidal signal (signal to noise). Activate the delta marker
before pressing Marker Noise or the reference marker units may be
incorrect.
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Marker Trace
Auto 1234

Key Reference
Marker

The noise marker averages 5% of the trace data values
(one-half a horizontal division), centered on the location
of the marker on the frequency or time scale. Marker
noise indicates noise power density per Hertz or noise
voltage per root Hertz depending upon the amplitude
units selected. The number of sweep points is noted in
parenthesis to the right of the sweep time in the lower
right corner of the graticule.

Note that the data values averaged will not always be
symmetrical with respect to the marker position. If the
marker is positioned within 2.5% of the beginning of the
trace (one-quarter division), the trace data values in the
first half-division will be averaged. Similarly, if the marker
is positioned within 2.5% of the end of the trace, the trace
data values in the last half-division will be averaged.

Do not use Marker Noise to evaluate the displayed average noise
level of the analyzer relative to the specification. Read the
displayed average noise level directly from the display or use the
normal marker. Refer to Application Note 150 for a discussion of
how noise is displayed on a spectrum analyzer.

To guarantee accurate data for noise-like signals, a
correction for equivalent noise bandwidth for each
resolution bandwidth is measured and included in the
measurement. The Marker Noise function accuracy is
optimal when the detector is set either to Average or to
Sample because neither of these detectors peak-biases
the noise.

Key access: |yt > Function

Places a marker on the selected trace, if no markers have been
previously turned on. If a marker is currently active, press Marker
Trace until 1, 2, 3, or 4 is underlined: the active marker moves to the
selected trace.
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Selecting Aute mode moves the marker to the automatically
selected trace. The trace selection will search for the lowest
numbered trace in the following mode order: Clear-write, Max-hold,
Min-hold and View. If there are no traces in any of these modes, it
selects trace 1.

Key access: |t > More

Marker Table  Compresses the graticule and displays marker information in a
table. The information includes the marker number, trace number,
marker type, X axis value, and the amplitude.

Key access: |jiie > More

On Activates/deactivates the marker table.
off Key access: |yt > More > Maker Table

PrevPage  displays the previous/next page of the marker

Next Page  table.
Key access: |t > More > Maker Table
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Marker->

Press accesses the following marker function softkeys:

Mkr—CF  Sets the frequency of the marker to the center frequency. In delta
mode, Mkr—CF sets the displayed trace center frequency to the
frequency of the marker delta value. Mkr—-CF is not available in
Zero span.

Key access:

Mkr—CF  Changes the center-frequency step size to match the value of the
Step  active marker. Press > CF Step to view the step size. The
step size is the frequency difference between the markers when
marker delta is active. Use this function to step from one signal

harmonic to another. Mkr— CF Step is not available in zero span.

Key access:

Activewdncii@tars Changes the display start frequency to the frequency of the active
Area marker. In delta mode, Mkr— Start sets the start frequency to the
marker delta value. Mkr— Start is not available in zero span.

Key access:

Mkr—Stop  Changes the stop frequency to the frequency of the active marker.
In Delta mode, Mkr—Stop sets the stop frequency to the marker
delta value. Mkr—-Stop is not available in zero span.

Measurement Key access:
Result ———

Mkr—Ref Lvl  Changes the reference level to the active marker value, moving the
marked point to the reference level (top line of the graticule). In
delta mode, Mkr— Ref Lvl sets the reference level to the amplitude
difference between the markers. (For example, if the difference is
-15 dB, the reference level -15 dBm.)

Key access:
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In the Spectrum Analyzer mode (see MODE), Meas key displays a
menu for measurements such as adjacent channel power,
occupied bandwidth, channel power, spectrum emission mask and
TOI. Press Measure Off to turn the measurement off.

Channel Power

Avg Number
On Off

Channel Power measures the power and power spectral density in
the specified channel bandwidth. A white frame on the display
indicates the edge limits of the channel bandwidth. The user must
specify the center frequency, reference level, and channel
bandwidth to be used for the measurement.

Figure 4-4 Channel Power Measurement
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Specifies the number of measurement averages used when
calculating the measurement result with Avg Number (On). The
range is 1 to 1000. Use the knob, the arrow keys or the numeric
keypad to set the number. The average will be displayed at the end
of each sweep. Selecting Off disables measurement averaging.

Key access: > Channel Power



Avg Mode
Exp Repeat

Integ BW

Chan Pwr
Span

Measurement
Result

Key Reference
Meas

Toggles the average mode between Exp or Repeat. This determines
the averaging action after the specified number of measurements
(average count) is reached.

When selecting Exp, each successive data acquisition after the
average count is reached is exponentially weighted and combined
with the existing average. Exponential averaging weights new data
more than old data, which facilitates tracking of slow-changing
signals. The average will be displayed at the end of each sweep.

When selecting Repeat, after reaching the average count, all
previous data is cleared and the average count is back to 1.

Key access: piZt > Channel Power

Specifies the range of integration used in calculating the power in
a channel. For example, set the main (center) channel bandwidth.
Note that the white frame indicates the integration bandwidth. Be
sure the span is set between 1 and 10 times the integration
bandwidth. Change integration bandwidth by using the knob and
the arrow keys.

Key access: piZt > Channel Power

Specifies the frequency span used for the channel power
measurement by using the knob and the arrow keys. Be sure the
span is set between 1 and 10 times the integration bandwidth.

Key access: piZt > Channel Power

-
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Occupied BW

Occupied Bandwidth integrates the power of the displayed
spectrum. The power-bandwidth routine first computes all signal
power contained in the trace, then calculates the span containing
the power of the specified percentage. The percentage value
default is 99% of the occupied bandwidth power.

For 99% occupied power bandwidth, Markers are placed at the
frequencies on either side of 99% of the power. 1% of the power is
evenly distributed outside the markers. The difference between the
marker frequencies is the 99% power bandwidth.

This is the main menu of occupied bandwidth measurement
including all related parameters and measurement results.

Figure 4-5 Occupied Bandwidth Measurement
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The occupied bandwidth function also indicates the difference
between the center frequency and the center frequency of the
channel. This “Transmit Freq Error” is defined

as the difference between the (f1 + f2)/2 and the tuned center
frequency of the signal.

To get the correct measurement result, first set the center
frequency, reference level, and channel spacing.



Avg Number
On Off

Avg Mode
Exp Repeat

Max Hold
On Off

Occ BW% Pwr

OBW Span

Key Reference
Meas

Select On to specify the number of measurement averages used
when calculating the measurement result. The average is displayed
at the end of each sweep. Select Off to disable measurement
averaging. The range is from 1 to 1000.

Key access: > Occupied BW

Toggles the termination control type used for the averaging
function between Exp and Repeat. This determines the averaging
action after the specified number of measurements (average count)
is reached.

When you select Exp, each successive data acquisition after the
average count is reached is exponentially weighted and combined
with the existing average. Exponential averaging weights new data
more than old data, which facilitates tracking of slow-changing
signals. The average is displayed at the end of each sweep.

When you select Repeat, after reaching the average count, all
previous data is cleared and the average count is reset to 1 and the
averaging process is restarted.

Key access: > Occupied BW

Toggles the maximum hold trace feature between On and Off.
Maximum hold displays and holds the maximum responses of a
signal.

Key access: > Occupied BW

Edits the percentage of signal power used when determining the
occupied bandwidth.

Key access: > Occupied BW

Specifies the integration range used to calculate the total power
from which the percent occupied bandwidth is then calculated.
The analyzer span will be set to the same value as the OBW Span
for the measurement. OBW Span should be set to an approximate
multiple of 2 times the expected occupied bandwidth result. The
range is from 100 Hz to 3 GHz.

Key access: > Occupied BW
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x dB

Specifies the power level used to determine the emission
bandwidth as the number of dB down from the highest signal
paint, within the occupied bandwidth span. This function is an
independent calculation from the OBW calculation. The x dB
Bandwidth result is also called the emissions bandwidth, or EBW.
Two arrows will be set to the specified dB value below the
maximum power level and the total power between the arrows will
be computed. Frequencies f1 and f2 are determined as the furthest
frequencies x dB below and above maximum power level,
respectively. The emission bandwidth is then calculated as f2 - f1
as shown by the arrows indicated in Figure 4-5 (note that the
diamond markers are for the OBW function). The range is from
-100.0 to -0.1 dB.

Key access: > Occupied BW

The asterisk next to the x dB bandwidth value in Figure 4-5
indicates the results may not have been determined with optimal
analyzer settings. If emission bandwidth is your primary interest,
select Max Hold. Then change detector mode to peak by pressing
> Detector > Positive Peak. Acquiring peak data ensures
accuracy of this measurement.



ACP

Avg Number
On Off

Avg Mode
Exp Repeat

Key Reference
Meas

Adjacent Channel Power (ACP) measures the power present in
adjacent transmit channels. The span is automatically set
according to the six available offsets and their associated
integration bandwidths as defined by the user.

Figure 4-6 Adjacent Channel Power Measurement

I
¥ w
o i vr\"“""\h"ﬂ‘r.i.r""\r*"~'.w-1vwa"',P‘"*",‘*.-w“"-"‘i“f\l

Pressing On specifies the number of measurements that will be
averaged when calculating the measurement result. The average
will be displayed at the end of each sweep. Pressing Off disables
the measurement averaging.

Key access: [J{2x > ACP

Enables the user to select the type of termination control used for
the averaging function (Exp or Repeat). This determines the
averaging action after the specified number of measurements
(average count) is reached.

When selecting Exp, each successive data acquisition after the
average count is reached is exponentially weighted and combined
with the existing average. Exponential averaging weights new data
more than old data, which facilitates tracking of slow-changing
signals. The average is displayed at the end of each sweep.
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Chan Integ
BW

Offset/Limits

When selecting Repeat, after reaching the average count, all
previous data is cleared and the average count is back to 1.

Key access: pi&x > ACP

Specifies the range of integration used in calculating the power in
the main channel. Use the knob and the arrow keys to set the

bandwidth.

Key access: piZx > ACP

Accesses softkeys that allow you to configure the offsets for the
ACP measurement.

Key access: pi£x > ACP

Offset
ABCDEF

Offset Freq
On Off

Ref BW

Pos Offset
Limit

Neg Offset
Limit

Selects the offset the softkeys will affect. Press
Offset until the letter of the desired offset is
underlined.

Key access: Wity > ACP > Offset/Limits

Sets the frequency difference from the center of the
main channel to the center of the offset for a
maximum of 6 offsets (labeled A-F). It also allows
you to turn On/Off the offsets that you want to
measure.

Key access: Wity > ACP > Offset/Limits

Sets the reference bandwidth (integration
bandwidth) for each offset.
Key access: > ACP > Offset/Limits

Sets the upper limit for the upper segment of the
specified offset pair.
Key access: Wity > ACP > Offset/Limits

Sets the upper limit for the lower segment of the
specified offset pair.
Key access: pitx > ACP > Offset/Limits



Meas Type

Method
IBW RBW

Total Pwr Ref
(PSD Ref)
Auto Man

Limits
On Off

Key Reference
Meas

Specifies the reference for the measurement, either Total Pwr Ref or
PSD Ref. Relative values are displayed referenced to either the total
power (Total Pwr Ref) or the power spectral density (PSD Ref)
measured in the main channel.

Key access: gy > ACP

Enables you to select the measurement method. The resolution
bandwidth (RBW) method is most useful for measuring cdmaOne
signals; the integration bandwidth method (IBW) is preferred for
other signals.

Key access: pizt > ACP > More

Sets the adjacent channel power reference to automatic or manual
when Meas Type is set to Total Pwr Ref. \When select Auto, the carrier
power result reflects the measured power value in the carrier.
When set to Man, the last measured value is captured and held, or
may be entered by the user. Relative values are displayed,
referenced to the total power measured in the main channel.

When Meas Type is set to PSD Ref, pressing this key sets the power
spectral density in the carrier (main channel) that is used to
compute the relative power spectral density values for the
offsets.When the PSD Ref state is set to Auto, this will be set to the
measured carrier power spectral density.

Key access: X > ACP > More

Turns limits testing on or off. When select On, each offset is
compared to its upper and lower offset limit. In those cases where
the power exceeds the limit, the calculated result will be displayed
in red to indicate a failure. If there are any failures, the pass/fail
indicator area show “FAIL” in red; if there are none, it shows “PASS”
in green when using IBW method. Neither “FAIL” nor “PASS” will be
displayed when using RBW method. Any offsets that are in the off
state are not measured and no results will be displayed.

Key access: WX > ACP > More
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Intermod (TOI)

Avg Number
On Off

Avg Mode
Exp Repeat

The third order intermodulation (TOI) measurement computes and
displays the output intercept point (IP3), and places arrows upon
the trace to indicate the measured signals and third-order
products.

Figure 4-7 TOI Measurement

Set Avg Number to On to specify the number of measurement
averages used when calculating the measurement result. The
average will be displayed at the end of each sweep. Setting
Avg Number to Off disables measurement averaging.

Key access: > More> Intermod (TOI)

Selects the type of termination control used for the averaging
function (Exp/Repeat). This determines the averaging action after
the specified number of measurements (average count) is reached.

When Avg Mode is Exp, Each successive data acquisition after the
average count is reached is exponentially weighted and combined
with the existing average. Exponential averaging weights new data
more than old data, which facilitates tracking of slow-changing
signals. The average is displayed at the end of each sweep.



TOI Span

Max Mixer Lvl
Auto Man

Key Reference
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When Avg Mode is Repeat, after reaching the average count, all
previous data is cleared and the average count is back to 1.

Key access: > More> Intermod (TOI)

Specifies the frequency span in which intermodulation products are
measured. If you modify the value of span in the base instrument
Span menu, the value in the Intermod (TOI) menu will be updated to
reflect the new value, and the measurement will restart if it is
running.

Key access: > More> Intermod (TOI)

Sets the relationship between the highest signal that can be
displayed (the reference level) and the input attenuation. The
relationship applies whenever the Attenuation is set to Auto. The
relationship is that the attenuation is given by reference level minus
the max mixer level. For example, as the reference level changes,
the input attenuator changes to ensure that a signal at the
reference level does not exceed the Max Mixer Lvl setting.

When the TOlI measurement is off, the previous maximum Max
Mixer Lvl is restored.

Pressing Auto sets the maximum mixer level to -30 dBm.
Key access: > More> Intermod (TOI)
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Spectrum Emission Mask

Avg Number
On Off

Meas Type

Spectrum Emission Mask measurement includes the in-band and
out-of-band spurious emissions. As it applies to W-CDMA (3GPP),
this is the power contained in a specified frequency bandwidth at
certain offsets relative to the total carrier power. It may also be
expressed as a ratio of power spectral densities between the carrier
and the specified offset frequency band. For WLAN, the reference
power is taken as the peak PSD in the signal, and all offset results
are also the peak PSD in that offset as opposed to the integrated
power.

Figure 4-8 Spectrum Emission Mask

Set Avg Number to On to specify the number of measurement
averages used when calculating the measurement result. The
average will be displayed at the end of each sweep. Setting
Avg Number to Off disables measurement averaging.

Key access: > More > Spectrum Emission Mask

Displays a menu to select a measurement reference type, Total Pwr
Ref or PSD Ref.

Key access: [{I2x, > More > Spectrum Emission Mask



Ref Channel
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Total Pwr Ref When Total Pwr Ref is selected, the power in the

PSD Ref

carrier is used as the reference in computing the
relative power values for the offsets.

Key access: > More > Spectrum Emission
Mask > Meas Type

When PSD Ref is selected, the mean power spectral
density of the carrier is used in computing the
relative power spectral density values for the
offsets.

Key access: > More > Spectrum Emission
Mask > Meas Type

Accesses the softkeys to change the reference channel settings.
Key access: > More > Spectrum Emission Mask

Chan Integ BW Specifies the integration bandwidth used in

Chan Span

Sweep Time
Auto Man

Res BW
Auto Man

calculating the power in the main channel.
Key access: > More > Spectrum Emission
Mask > Ref Channel

Specifies the span used in measuring the power in
the main channel.

Key access: > More > Spectrum Emission
Mask > Ref Channel

Specifies the sweep time used in measuring the
power in the main channel.

Key access: > More > Spectrum Emission
Mask > Ref Channel

Specifies the resolution bandwidth used in
measuring and the power in the main channel.
Key access: > More > Spectrum Emission
Mask > Ref Channel
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Total Pwr Ref  Displays the type of power measurement reference

(PSD Ref) selected by Meas Type.

Auto Man Total Pwr Ref is the power in the carrier that is used
as the reference in computing the relative power
values for the offsets. When Man is selected, this
can be set by the user. When Auto is selected, this
is the measured power in the reference carrier.
PSD Ref is the mean power spectral density in the
carrier that is used as the reference in computing
the relative power spectral density values for the
offsets. When Man is selected, this can be set by
the user. When Auto is selected, this is the
measured mean power spectral density in the
reference carrier.

Key access: > More > Spectrum Emission
Mask > Ref Channel

Offset/Limits  Displays the menus to change the following parameters for offset
frequency settings and pass/fail tests: Offset, Start Freq, Stop Freq,
Sweep Time, Res BW, and Limits. Refer to the tables below for
default settings of particular radio standards of interest.

Key access: > More > Spectrum Emission Mask

Table T Offsets & Limits Defaulted for W-CDMA (3GPP) Base Station Measurements?

Offset Start Stop Res BW Abs Abs Abs Rel Rel Stop |Meas
Freq Freq (kHz) Start Stop Couple Start (dBc) BW
(MHz) | (MHz) (dBm) | (dBm) (dBc)
A.On 2515 2.715 30.00 -14.00 -14.00 Couple | -30.00 -30.00 1
B. On 2.7115 3.515 30.00 -14.00 -26.00 Man -30.00 -30.00 1
C.0On 3,515 4.000 30.00 -26.00 -26.00 Couple | -30.00 -30.00 1
D.On 4.000 8.000 1000.00 |-13.00 -13.00 Couple | -30.00 -30.00 1
30.00 33
E. On 8.000 12.500 |{1000.00 |-13.00 -13.00 Couple | -30.00 -30.00 1

a. Fail Mask is set to Absolute and Rel Stop is set to Couple.
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Table 2 Offsets & Limits Defaulted for W-CDMA (3GPP) Mobile Station Measurements®?
Offset Start Stop Res BW Abs Abs Rel Rel Rel Stop |Meas
Freq Freq (kHz) Start Stop Couple Start (dBc) BW
(MHz) | (MHz) (dBm) | (dBm) (dBc)
A.On 2.515 3.485 30.00 -71.07 | -71.07 Man -35.23 -49.78 1
B. On 4.000 7.500 10000 |-55.84 |-55.84 Man -35.50 -39.00 1
C.0n 7.500 8.500 |1000.00 |-55.84 |-55.84 Man -39.00 -49.00 1
D.On 8.500 12.000 |1000.00 |-55.84 |-55.84 |Couple | -49.00 -49.00 1
E. Off 12500 | 15.000 |1000.00 |-55.84 |-55.84 |Couple | -49.00 -49.00 1

Table 3  Offsets & Limits Defaulted for 802.11a and HiperLAN/2 Radio Standards?

a. Abs Stop is set to Couple and Fail Mask is set to Abs AND Rel.

Offset Start Stop Abs Abs Abs Rel Rel Stop Rel Meas
Freq Freq Start Stop Couple Start (dBc) Couple BW
(MHz) | (MHz) |(dBm) | (dBm) (dBc)

A.On 9.00 11.00 16.00 -4.00 Man 0.00 -20.00 Man 1

B. On 11.00 20.00 -4.00 -12.00 Man -20.00 -28.00 Man 1

C.On 20.00 30.00 -12.00 -24.00 Man -28.00 -40.00 Man 1

D. On 30.00 50.00 -24.00 -24.00 Couple -40.00 -40.00 Couple 1

E. Off 50.00 100.00 | -24.00 -24.00 Couple | -40.00 -40.00 Couple 1

a. Res BW is set to 100 kHz and Fail Mask is set to Rel.
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Table 4  Offsets & Limits Defaulted for 802.11b Radio Standard?
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Offset Start Freq [Stop Freq |Abs Start |[Abs Stop |Rel Start |Rel Stop Meas
(MHz) (MHz) (dBm) (dBm) (dBc) (dBc) BW

A.On 11.00 22.00 -10.00 -10.00 -30.00 -30.00 1

B. On 22.00 50.00 -30.00 -30.00 -50.00 -50.00 1

C. off 50.00 70.00 -30.00 -30.00 -50.00 -50.00 1

D. Off 70.00 90.00 -30.00 -30.00 -50.00 -50.00 1

E. Off 90.00 100.00 -30.00 -30.00 -50.00 -50.00 1

Offset

Start Freq
On Off

Stop Freq

Sweep Time
Auto Man

a. Res BW is set to 100 kHz, Fail Mask is set to Rel, and Abs Stop
and Rel Stop are both set to Couple.

Select the offset pairs (upper and lower) that the softkeys will affect,
and displays the memory selection menu from A to E (the analyzer
can store up to 5 sets of values for Start Freq, Stop Freq, Sweep Time,
Res BW, Meas BW, Abs Start, Abs Stop, etc.). Press Offset to select
the letter of the desired offset is underlined. Only one selection at a
time is shown on this key label.

Key access: > More > Spectrum Emission Mask > Offset/Limits
Specifies the inner limit (frequency closest to the carrier) for both
segments of the specified offset pair. When Start Freq (0ff) is
selected, the offset pair is not measured.

Key access: > More > Spectrum Emission Mask > Offset/Limits
Specifies the outer limit (frequency furthest from the carrier) for
both segments of the specified offset pair. The minimum frequency
difference between Start Freq and Stop Freq is limited to 100 Hz.
Key access: > More > Spectrum Emission Mask > Offset/Limits
Specifies the sweep time for the currently selected offset, and
toggles this function between Auto and Manual for each offset.

Key access: > More > Spectrum Emission Mask > Offset/Limits




Res BW
Auto Man

Abs Start

Abs Stop
Couple Man

Rel Start

Rel Stop
Couple Man

Fail Mask

Key Reference
Meas

Specifies the resolution bandwidth used in measuring the offset
pair. When set to Aute, the Res BW from the default tables for
"Offset/Limits" on page 133 are used. When set to Man, the
allowed range is 1 kHz to TMHz.

Key access: > More > Spectrum Emission Mask > Offset/Limits

To enter an absolute level limit at Start Freq for the currently
selected offset ranging from -200.00 to +50.00 dBm with 4
significant digits.

Key access: > More > Spectrum Emission Mask > Offset/Limits
> More

To enter an absolute level limit at Stop Freq for the currently
selected offset ranging from —-200.00 to +50.00 dBm with 4
significant digits, and to toggle this function between Couple and
Man. If set to Couple, this is coupled to Abs Start to make a flat limit
line. If set to Man, Abs Start and Abs Stop the user can enter different
values to make a sloped limit line.

Key access: > More > Spectrum Emission Mask > Offset/Limits
> More

Enters a relative level limit at Start Freq ranging from -150.00 to
+50.00 dBc with 4 significant digits.

Key access: > More > Spectrum Emission Mask > Offset/Limits
> More -

Enters a relative level limit at Stop Freq ranging from -150.00 to
+50.00 dBc with 4 significant digits, and to toggle this function
between Couple and Man. If set to Couple, this is coupled to Rel Start
to make a flat limit line. If set to Man, Rel Start and Rel Stop the user
can enter different values to make a sloped limit line.

Key access: > More > Spectrum Emission Mask > Offset/Limits
> More

Displays the menu to select one of the following logic keys for fail
conditions between the measurement results and the test limits:
Absolute, Relative, Abs AND Rel, and Abs OR Rel.

Key access: > More> Spectrum Emission Mask > Offset/Limits
> More > More
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Meas BW

Absolute

Relative

Sets the limit test to show Fail if one offset is larger
than the corresponding limit for Abs Start and/or Abs
Stop. This is the default selection for each offset for
BTS measurements.

Sets the limit test to show Fail if one offsets
spectrum emission mask measurement results is
larger than the corresponding limit for Rel Start
and/or Rel Stop.

Abs AND Rel Set the limit test to show Fail if one offset’s spectrum

Abs OR Rel

emission mask measurement results is larger than
both the corresponding limit for Abs Start and Abs
Stop and the limit for Rel Start and Rel Stop.

Set the limit test to show Fail if one offset’s the
absolute spectrum emission mask measurement
results is larger than the corresponding limit for Abs
Start and Abs Stop or the limit for Rel Start and Rel
Stop.

Specifies the bandwidth to use when measuring the offset. When
using the front panel, only the currently selected offset is affected.
All the offsets are affected when remote control. This is the
multiplier applied to the resolution bandwidth to determine the
bandwidth to integrate when calculating the power. Meas BW is
now restricted to be 1 and not changeable.

Key access: > More > Spectrum Emission Mask > Offset/Limits
> More > More
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MODE

Selects the measurement mode of your analyzer.
Spectrum Analyzer mode is the default mode and is for general
purpose measurement use.

Tracking Generator

Accesses the tracking generator functions. (Option TG3)

Key access: S0

Amplitude TG
On Off

Attenuation

Amptd Offset
On Off

Activates (On) or deactivates (0ff) the tracking
generator output. The power level can then be
adjusted using the numeric keypad, arrow keys
or knob. Pressing any digit, O through 9, on the
numeric keypad brings up the selected
terminator menu. The output level range is -30
dBm to 0 dBm.

Key access: > Tracking Generator

To set the output attenuation level of the
tracking generator using the tracking generator
output attenuator. The available level is 0 to 30
dB in 6 dB steps.The default setting is 18 dB.
Key access: > Tracking Generator

Amptd Offset (On) allows you to offset the
displayed power of the tracking generator. Using
the amplitude offset capability of the tracking
generator allows you to take system losses or
gains into account, thereby displaying the actual
power delivered to the device under test.

Key access: > Tracking Generator
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Amptd
Step
Auto Man

Power
Sweep

Normalize

To set the step size of the power level range of the tracking
generator. The default setting is one vertical scale division
when in a logarithmic amplitude scale.
Key access: [§fi, > Tracking Generator

Sweep the output offset of the tracking generator. The
analyzer continues to sweep the linear change between
start and stop frequency when power sweep is on. The
input range is 0 dB to 10 dB.

Key access: [y > Tracking Generator > More

Accesses the following softkeys.

Store Ref
(1->3)

Normalize
On Off

Copies trace 1 into trace 3. Softkey menu
Store Ref (1->3) must be pressed before
pressing Normalize (On).

Activates the normalize function. On each
sweep, the normalized trace (Trace 3) is
subtracted from Trace 1 and the result is
added to the normalized reference level.

The trace data is normalized with respect to
the normalized reference level, even if the
value of the normalized reference level is
changed. This function remains in effect on
all subsequent sweeps until it is turned off.

The normalize function is most useful for
applying correction data to a trace while
making a stimulus response measurement
with a tracking generator. For example,
connect the cables and a thru line, in place of
the device to be measured,

Trace 1 should be in clear write mode prior to setting normalize to

on.
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between the tracking generator and the
analyzer input. Notice that the frequency
response is not perfectly flat, showing the
response of the cables, as well as the flatness of
both the tracking generator and the analyzer.
Now press Store Ref (1->3), Normalize (On).
Notice that the displayed trace is now flat, or
normalized. The position of the normalized trace
can now be moved to a different position on the
display by changing the normalized reference
position. This may be useful if the device to be
tested has positive gain, such as an amplifier.
Now, replace the thru line with the device under
test, and an accurate measurement of the gain
or loss can be made.

Norm Ref Lvl Sets the level (in dB) of the normalized

Norm Ref
Posn

Ref Trace

reference.

Offsets the displayed trace without affecting the
instrument gain or attenuation settings. This
allows the displayed trace to be moved without
decreasing measurement accuracy. The
normalized reference position is indicated with a
(>) character on the left side of the display and a
(<) character on the right side of the display.

Allows you to view or blank the reference trace

View Blank on the display.
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Tracking Activates a routine that automatically adjusts fine frequency

Peak

tracking to obtain the peak response of the tracking
generator on the spectrum analyzer display. Tracking Peak is
performed in the current resolution bandwidth.

Key access: [y > Tracking Generator > More

Man Track  Allows you to manually adjust the frequency of the tracking

adj

generator oscillator using the step keys, knob, or numeric
keypad. The tracking adjust is tuned to maximize the
amplitude of the trace.

Key access: {1y > Tracking Generator > More

When in the Tracking Generator mode, resolution bandwidths < 30
kHz are not available.
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Power Meter

Zero/Cal

Meas Disp

Use the arrow keys to highlight the mode and press [ENTER] to
make a measurement using the power meter function.

When this mode is selected, the power meter related softkey menu
will be displayed and many of the instrument hardkeys will be
disabled as they are not necessary for this mode.

Key access: [0

Accesses the associated Zeroing submenu.

Key access: iy > Power Meter

Zero Makes a Zero operation of the power sensor.

The U2000 Series USB Power Sensors have their
sensor calibration tables stored in non- volatile
memory which means that the reference calibration
factor is automatically loaded upon power-up.

Key access: > Power Meter > Zero/Cal

Zero Type Toggles the zeroing type of the Power Sensor between
internal and external. When this type is set to EXT,
pressing Zero will bring up a message which indicates
the external signal need be pulled out. This setting is
not affected by the preset in Power Meter menu.

Key access: > Power Meter > Zero/Cal

Accesses the Meas Disp submenu for defining the display range

and resolution while in Power Meter mode.
Key access: [§{i) > Power Meter

143



Key Reference
MODE

Disp
Range

Resolutio
n
1234

Accesses the associated Disp Range submenu.
Key access: [E[13, > Power Meter > Meas Disp

Auto
Range

Top

Bottom

Toggles the auto range function between On
and Off. When the Auto Range is set to On, the
Top and Bottom value of the power meter’s
display range will be set automatically
according to the measurement data:

Top = Max. data + 0.5

Bottom = Min. data - 0.5

The default setting is Off.

Sets the top value of the power meter’ display
range.

Range from (Bottom + 0.01) to 200 dBm.
The default value is 20 dBm.

Sets the bottom value of the power meter’
display range.

Range from - 200 to (Top - 0.01) dBm.
The default value is - 70 dBm.

Accesses the associated Resolution submenu.

When the measurement suffix is W or %, this parameter
represents the number of significant digits. When the

measurement suffix is dB or dBm, 1 through 4 represents
1,0.1,0.01, and 0.001 dB respectively. The default value

is 3.

Key access: [§{13 > Power Meter

Meas Setup  Accesses the power meter measurement setup submenu.
Key access: [§{) > Power Meter
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Dis Mode Changes the display mode between Meter and Chart.
Meter Chart 1 gefault mode is Meter.

Key access: > Power Meter > Meas Setup
Chart View  Accesses the Chart View submenu. This soft key is

disabled when the measurement is in process or if the
display mode is set to Meter.

This submenu is used to view the measurement chart.
Key access: > Power Meter > Meas Setup

Home View the first 21 points of current
measurement chart.

End View the last 21 points of current
measurement chart.

Prev View the previous points of the chart.
Next View the next points of the chart.

Pause/ Continues or pauses the current measurement.

Continue  \when the measurement is in process, this softkey is

displayed as “Pause”; when the measurement is
paused, the softkey is displayed as “Continue”.

Key access: > Power Meter > Meas Setup

Preset  Sets the Power Meter softkey menu options to the preset
conditions. This softkey is the hotkey for > {Preset}.
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AM/FM Modulation Analysis

Use the arrow keys to highlight the mode you need and press
[ENTER] as a terminator. When this mode is selected, the AM/FM
modulation analysis menu will be displayed.

Carrier Freq  Sets the modulated carrier frequency.
Key access: m > AM/FM Modulation Analysis

IFBW  This specifies the IF bandwidth for the signal to be analyzed. The
measurement accuracy will be impacted if this value isn’t set
precisely.

Key access: [§{33 > AM/FM Modulation Analysis

EqLPF  This specifies the IF bandwidth for the signal to be analyzed. The
measurement accuracy will be impacted if this value isn’t set
precisely.

Key access: [§{33 > AM/FM Modulation Analysis

Filter Setup  Accesses the Filter setup submenu for further configuration.
Key access: [0 > AM/FM Modulation Analysis

Meas Selects the Measure Filter as Root Nyquist, Nyquist,
Filter and Gaussian.

Ref Filter Selects the Measure Filter as Root Nyquist, Nyquist,
and Gaussian.

Alpha/Bb Sets the root-off factor a for Root Nyquist and Nyquist
T filter or BbT for Gaussian filter.

Filter Sets the symbol numbers for the selected filter. The

Symbols allowed value range is from 2 to 25.

View  Accesses the submenu to select four display mode:
Symbol - displays the binary symbol in full screen/window.
Waveform - displays the signal waveform.
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Meas Length

Average
On Off
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AM Error - displays the AM error.
Eye Diagram - Displays the Eye diagram.
Key access: [0 > AM/FM Modulation Analysis

Accesses the submenu to configure the X scale parametes:
Scale/Div sets the number of symbols in one division.

Ref Value sets the starting value in term of times at the reference
position.

Ref position sets the display reference position to either Left, Ctr
(center), or Right. If the Auto scale key is set to on, these
parameters are adjusted automatically according to the
measurement result.

Key access: [§{31 > AM/FM Modulation Analysis

Accesses the submenu to configure the X scale parametes:
Scale/Div sets the number of symbols in one division.

Ref Value sets the starting value in term of times at the reference
position.

Ref position sets the display reference position to either Top, Ctr
(center), or Bottom.

The Ext Gain is set to add the external gain to the test result. If the
Auto scale key is set to on, these parameters are adjusted
automatically according to the measurement result.

Key access: [§{31 > AM/FM Modulation Analysis

Sets the number of symbols which will be used in calculating the
measurement.

Key access: [§{33 > AM/FM Modulation Analysis > More

Specifies the display measurement result format. When the
Average Number is set to off, the column title "Average" in
numerical results view will be changed to "Current".

Key access: [0 > AM/FM Modulation Analysis > More

147



Key Reference
MODE

148

Trigger

Limits

Sweep

Enables you to configure the trigger. When using a trigger source
other than Free Run, the analyzer will begin a sweep only with the
selected trigger conditions are met. A trigger event is defined as
the point at which your trigger source signal meets the specified
trigger level.

Free Run - New sweep starts as soon as possible after the current
sweep ends.

RF Trigger - Activates the trigger condition that starts the next
sweep if the detected RF envelope voltage rises to a level set by
the RF trigger level.

Ext Rise/Fall - Activates the trigger condition that will start a
sweep when the external voltage passes through 2 volts. The
external trigger signal must be a 0V to +5 V TTL signal. Sets the
trigger polarity to positive/negative.

Trig Delay - Allows you to set and turn on or off a delay, during
which the analyzer will wait to begin a sweep after receiving an
external trigger signal.

Key access: [§{31 > AM/FM Modulation Analysis > More

Set a limit value to warn you if the measured value exceeds the
value specified here. The test reuslt will be in purple if this reslut
exceeds the corresponding limit value.

Limit - Turns on/off the limit function

CarrPow Upr - Sets the carrier power upper limit

FregDev Up/Low - Sets the frequency deviation upper/lower limit
CarrFreOff Up - Sets the carrier frequency offset upper limit

Key access: [0 > AM/FM Modulation Analysis > More

Togglese the sweep type between single and continuous in AM/FM
mode. When this softkey is set to Single, press the next Single
softkey to execute a new sweep as soon as the trigger condition is
met.

Key access: [§{3) > AM/FM Modulation Analysis > More
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CarrFreq Step

Auto CarrFreq
On Off

Attenuation
Auto Man

Preamp
On Off

Key Reference
MODE

When the analyzer is in continuous sweep mode, pressing this
softkey will change the sweep setting to single sweep. It will then
begin a sweep after the trigger conditions are met.

If the analyzer is already in single sweep, pressing this softkey will
execute a new sweep as soon as the trigger condition is met.

If average is on pressing this softkey will halt averaging of the
current value, and then continue averaging from the current count
number when a single sweep function triggers.

Key access: [§{23 > AM/FM Modulation Analysis > More

Changes the step size for the center frequency function. Once a
step size has been selected and the center frequency function is
activated, the arrow keys change the center frequency by the
step-size value. The step size function is useful for finding
harmonics and sidebands beyond the current frequency span of the
analyzer.

Key access: [§{3) > AM/FM Modulation Analysis > More > More

This function can remedy the carrier frequency deviation when the
deviation less than symbol rate b.

Key access: [§{31 > AM/FM Modulation Analysis > More > More

Toggles the input attenuation between Auto or Man. Please refer to
page 90 for further information.

Key access: [§{3) > AM/FM Modulation Analysis > More > More
Toggles the internal preamp between On and Off. Please refer to

for page 91 further information.
Key access: [§{23 > AM/FM Modulation Analysis > More > More
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ASK/FSK Modulation Analysis

Carrier Freq

Symbol Rate

Filter Setup

View

Use the arrow keys to highlight the mode you need and press
[ENTER] as a terminator. When this mode is selected, the ASK/FSK
modulation analysis menu will be displayed.

Sets the modulated carrier frequency.
Key access: [{[20 > ASK/FSK Modulation Analysis

This specifies the fundamental symbol rate of the signal to be
analyzed. The values should be positive. The non-positive value will
be converted to THz. The measurement accuracy will be impacted
if this value isn’t set precisely.

Key access: [[30 > ASK/FSK Modulation Analysis

Accesses the Filter setup submenu for further configuration.
Key access: [§[30 > ASK/FSK Modulation Analysis

Meas Selects the Measure Filter as Root Nyquist, Nyquist,
Filter and Gaussian.

Ref Filter Selects the Measure Filter as Root Nyquist, Nyquist,
and Gaussian.

Alpha/Bb Sets the root-off factor a for Root Nyquist and Nyquist
T filter or BbT for Gaussian filter.

Filter Sets the symbol numbers for the selected filter. The
Symbols allowed value range is from 2 to 25.

Accesses the submenu to select four display mode:
Symbol - displays the binary symbol in full screen/window.
Waveform - displays the signal waveform.

ASK Error - displays the ASK error.

Eye Diagram - Displays the Eye diagram.

Key access: [§[33 > ASK/FSK Modulation Analysis
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Y Scale

Meas Length

Average
On Off
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Accesses the submenu to configure the X scale parametes:
Scale/Div sets the number of symbols in one division.

Ref Value sets the starting value in term of times at the reference
position.

Ref position sets the display reference position to either Left, Ctr
(center), or Right. If the Auto scale key is set to on, these
parameters are adjusted automatically according to the
measurement result.

Key access: [§[33 > ASK/FSK Modulation Analysis

Accesses the submenu to configure the X scale parametes:
Scale/Div sets the number of symbols in one division.

Ref Value sets the starting value in term of times at the reference
position.

Ref position sets the display reference position to either Top, Ctr
(center), or Bottom.

The Ext Gain is set to add the external gain to the test result. If the
Auto scale key is set to on, these parameters are adjusted
automatically according to the measurement result.

Key access: [§[21 > ASK/FSK Modulation Analysis

Sets the number of symbols which will be used in calculating the
measurement.

Key access: [§fi) > ASK/FSK Modulation Analysis > More

Specifies the display measurement result format. When the
Average Number is set to off, the column title "Average" in
numerical results view will be changed to "Current".

Key access: [§{i1 > ASK/FSK Modulation Analysis > More
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Trigger

Limits

Sweep

Enables you to configure the trigger. When using a trigger source
other than Free Run, the analyzer will begin a sweep only with the
selected trigger conditions are met. A trigger event is defined as
the point at which your trigger source signal meets the specified
trigger level.

Free Run - New sweep starts as soon as possible after the current
sweep ends.

RF Trigger - Activates the trigger condition that starts the next
sweep if the detected RF envelope voltage rises to a level set by
the RF trigger level.

Ext Rise/Fall - Activates the trigger condition that will start a
sweep when the external voltage passes through 2 volts. The
external trigger signal must be a 0V to +5 V TTL signal. Sets the
trigger polarity to positive/negative.

Trig Delay - Allows you to set and turn on or off a delay, during
which the analyzer will wait to begin a sweep after receiving an
external trigger signal.

Key access: [§[i) > ASK/FSK Modulation Analysis > More

Set a limit value to warn you if the measured value exceeds the
value specified here. The test reuslt will be in purple if this reslut
exceeds the corresponding limit value.

Limit - Turns on/off the limit function

CarrPow Upr - Sets the carrier power upper limit

FregDev Up/Low - Sets the frequency deviation upper/lower limit
CarrFreOff Up - Sets the carrier frequency offset upper limit

Key access: [§f11 > ASK/FSK Modulation Analysis > More

Togglese the sweep type between single and continuous in
ASK/FSK mode. When this softkey is set to Single, press the next
Single softkey to execute a new sweep as soon as the trigger
condition is met.

Key access: [§fi > ASK/FSK Modulation Analysis > More
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CarrFreq Step

Auto CarrFreq
On Off

Attenuation
Auto Man

Preamp
On Off
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When the analyzer is in continuous sweep mode, pressing this
softkey will change the sweep setting to single sweep. It will then
begin a sweep after the trigger conditions are met.

If the analyzer is already in single sweep, pressing this softkey will
execute a new sweep as soon as the trigger condition is met.

If average is on pressing this softkey will halt averaging of the
current value, and then continue averaging from the current count
number when a single sweep function triggers.

Key access: [§fi) > ASK/FSK Modulation Analysis > More

Changes the step size for the center frequency function. Once a
step size has been selected and the center frequency function is
activated, the arrow keys change the center frequency by the
step-size value. The step size function is useful for finding
harmonics and sidebands beyond the current frequency span of the
analyzer.

Key access: [ > ASK/FSK Modulation Analysis > More > More

This function can remedy the carrier frequency deviation when the
deviation less than symbol rate b.

Key access: [0 > ASK/FSK Modulation Analysis > More > More

Toggles the input attenuation between Auto or Man. Please refer to
page 90 for further information.

Key access: [0 > ASK/FSK Modulation Analysis > More > More
Toggles the internal preamp between On and Off. Please refer to

for page 91 further information.
Key access: [0 > ASK/FSK Modulation Analysis > More > More
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Peak Search

Next Peak

Next Pk Right

Next Pk Left

Places a marker on the highest peak based on the settings of the
"Search Criteria" on page 154. Refer to "Peak Search
Type" on page 155, for more information on the effect of
settings.

All peak search functions ignore the LO feed through signal. The
process for determining if the Peak is the LO feed through takes
into account Start Frequency, Span, Resolution Bandwidth,
Resolution Bandwidth shape factor, and Frequency Accuracy. If
there is no point of inflection within the LO feed through range, the
point on the trace with maximum amplitude, that is higher in
frequency than the LO feed through, will be selected.

Performs peak search as described above.
Key access:

Places the marker on the next highest peak. The signal peak must
exceed the peak threshold value by the peak excursion value. If
there is no peak, the marker will not move.

Key access:

Moves the marker to the next peak to the right of the current
marker position. The signal peak must exceed the peak threshold
value by the peak excursion value. If there is no peak to the right,
the marker will not move and the “No Peak Found” error message
will appear on the display.

Key access:

Moves the marker to the next peak to the left of the current marker
position. The signal peak must exceed the peak threshold value by
the peak excursion value. If there is no peak to the left, the marker
will not move and the “No Peak Found” error message will appear on
the display.

Key access:



Min Search

Pk-Pk Search

Continuous Pk
On Off

N dB Points
On Off

Search Criteria

Key Reference
Peak Search

Moves the active marker to the minimum detected amplitude.
Key access:

Finds and displays the frequency (or time, if in zero span), and
amplitude differences between the highest and lowest trace points.

Key access:

When Continuous Pk is on, the marker will remain on the peak signal
even if the frequency of that signal changes. The marker will remain
on that signal as long as the amplitude of the signal does not
change by more than 3 dB from one sweep to another.

If the signal is lost, the marker will attempt to find it again and
maintain on the peak. If there are other signals on screen near the
same amplitude, one of them may be found instead. Signals near O
Hz cannot be maintained effectively.

This function is intended to maintain the marker on signals with a
frequency that is changing, and an amplitude that is not changing.

Key access: R&i8 > More

Activates the N dB function. Pressing N dB Points (On) activates two
arrows that are N dB down from the marker. The frequency
difference between the two arrows will be displayed in the upper
right-hand corner of the display.

Key access: 8 > More

Search

Accesses the submenu to set the criteria for peak search.
Key access: [ > More

Search

Peak Excursion  Sets the minimum amplitude variation of signals
that the marker identifies as a peak. If a value of
10 dB is selected, the marker moves only to
peaks that rise and fall more than 10 dB above
the peak threshold value. When the peak
excursion is 6 dB or higher,
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Two signal peaks, which are so close together that the amplitude drop
between them is less than the peak-excursion value, are not
recognized as two peaks. A signal peak is recognized only if it has a
peak excursion drop above the noise floor, on both sides of the signal.

Peak
Threshold

Threshold
Hidden

Peak Search
Type

the marker-peak does not recognize signals less
than peak-excursion value above the noise floor. To
correct this, when measuring signals near the noise
floor, reduce the excursion value. To prevent the
marker from identifying noise as signals, reduce the
noise floor variance less than the peak-excursion
value by reducing the video bandwidth or by using
video averaging.

Key access: §$3 > More >Search Criteria

Sets the minimum amplitude that the marker can
identify as a peak. For example, if set to -90 dBm,
the marker moves only to peaks that rise and fall
more than the peak excursion above -90 dBm. Only
functional when in Excursion and Threshold marker
mode.

Key access: [$% > More > Search Criteria

Search

Hides the threshold line from being displayed on the
screen.
Key access: [558 > More > Search Criteria

Search

Selects the peak search mode.

Key access: gg;:;_h > More > Search Criteria

Max Value A Peak search with Max Value type
places a marker on the highest peak,
excluding the LO feedthrough peak.

Max Value A Peak search with Max Value type
places a marker on the highest peak,
excluding the LO feedthrough peak.



Peak Table

Key Reference
Peak Search

Excursion & When Peak Search Type is Excursion &

Threshold Threshold, a peak search places a
marker on a peak that meets the Peak
Excursion and Peak Threshold
parameters. If Peak Search Type is
Excursion & Threshold and no peak
satisfies the selected parameters, a
marker is placed at the center of the
trace, and the error message, “No Peak
Found” will appear.

Accesses the following Peak Table softkeys to set a peak table.

Key access:

Peak Table
On Off

Peak Sort
Freq Amptd

Peak
Search > More

Displays a list of up to 12 signal peaks that is
updated at the end of each sweep. The peak table
function works with trace 1 only.

Key access: B8 > More > Peak Table

Search

Switches the peak table sorting routine between
listing the peaks in order by descending amplitude
or frequency.

Key access: [5 > More > Peak Table

Search
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Preset/System

158

Preset

Accesses the Preset and System softkeys. When the analyzer is in

the remote mode, pressing returns the analyzer to the local

control mode and enables front-panel inputs.

Provides a known state of the instrument for making
measurements. The analyzer allows you to select whether a user
preset, or factory preset is performed.

System

a factory default preset, which performs the To lowing:
Resets the analyzer to Spectrum Analyzer (SA) mode
Brings up the Frequency menu
Sets certain conditions to their default values
Clears all trace data

If Preset Type is set to Factory Def., pressing 554 > Preset performs

Turn limit line testing off, but the limit line tables remain in
analyzer memory

See Table Factory Default Preset States for the conditions
established by performing a factory default preset.

If Preset Type is set to Factory, pressing > Preset performs a
factory preset, which performs the following:

Sets certain conditions to their default values

Clears all trace data

Turn limit line testing off, but the limit line tables remain in
analyzer memory

When Preset Type is set to User, pressing &+ > Preset displays
the softkeys User Preset and Factory Preset, you then select the
specific preset as you need.

Key access:



Key Reference

Preset/System

Factory Default Preset State
Attenuation 20 dB(Auto) Average Type Video (Auto)
Center frequency 1.5 GHz Averaging 1(0ff)
CF step size 300 MHz Peak Excursion 6dB
Start Frequency O Hz Peak Threshold -90 dBm
Stop Frequency 3 GHz Peak Search Type Max Value
Signal Track Off Peak Table Off
Span 3 GHz Peak Sort Amplitude
Reference level 0dBm Continuous Pk Off
Log scale/Division 10dB Delta Pair Delta
Int Preamp Off Span Pair Center
Trace 1 Clear Write Trigger Free Run
Trace 2, 3, 4 Blank Markers Normal(Off)
Sweep Time 346.7 ms(Auto) Marker Delta Off
Sweep Continuous Marker Table Off
Limit off Measure Meas Off
Limit line testing Off File Catalog Local
Limit point 0 File Type State
Detector Peak(Auto) File Sort By Date
Display line -25 dBm(0ff) Phase Noise Off
Video bandwidth 3 MHz(Auto) Optimize phase noise | Off
VBW/RBW ratio 1.000 (Auto) Frequency Counter Off
Resolution 3 MHz(Auto) Frequency counter 1 kHz(Auto)
bandwidth resolution
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Pwr on/Preset

Alignment

Upgrade

160

Accesses the following softkeys for the preset settings.

Key access:

Power on
Last Preset

Preset Type

Save User
Preset

rese

System

Determines the state of the analyzer when the
analyzer is turned on. Power On set to Preset recalls
the analyzer settings previously with the Preset
function. Power On set to Last recalls the analyzer
settings when the analyzer is turned off by the front
panel power switch.

Selects User or Factory preset settings.

User Pressing Preset recalls the analyzer settings
defined by Save User Preset.

Factory Pressing Preset recalls the analyzer settings
originally set at the factory.

Saves the active settings of the analyzer into the User
Preset register. To recall these settings, select Preset
Type to User.

Accesses the following softkeys that align the internal circuitry of
the analyzer, load default values for the alignment system, and
adjust the 10 MHz reference.

Key access:

Align

Accesses the Align softkeys.

All Initiates the alignment of systems with a
(Ext Cable) cable connected from the CAL OUT to RF
IN (Except option TG3).

CALOUT  Turns the internal amplitude reference
On Off signal on or off. When this signal is on,
the RF input is disabled.

Enables the firmware upgrade process once the USB disk with the
firmware upgrade package plug connected.

Key access:

rese

System



Language

Diagnostics

Show System

Show
Hardware

Show
Software

Show Errors

Key Reference
Preset/System

Accesses the softkeys for selecting the screen menu language. In
addition to English, there are ten more user-selectable, on-screen
languages, including Chinese, Japanese, Korean and a number of
European languages.

Key access:

Accesses the Front Panel Test softkey to verify the functionality of
each front-panel key. The number next to each key name
increments once each time the key is pressed. Rotating the knobs
causes the number of pulses to be counted. Press Return will go
back to the main menu.

Key access:

Displays the number and description of the options installed in
your analyzer. It also displays the instrument model number,
product number, serial number, the date of production, etc.

Key access: B84 > More

System

Provides detailed information about the hardware installed on the
analyzer, including the model number and firmware revision.

Key access: [§5# > More

Provides the detailed information on the installed software.

Key access: [{§5# > More

Accesses a list of the 100 most recent errors reported. The most
recent error will appear at the bottom of the list. The first error
listed will be removed if the error list is longer than 20 entries. If the
same error occurs continuously, that error message will not be
added repeatedly to the list. Refer to "Instrument Messages" on
page 171 for details.

Key access: &84 > More

Prev Page/ Access the previous/next page of error
Next Page messages.

Clear Error Queue Clears all the errors in the errors queue.
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Time/Date

10 Config

Licensing

Accesses the following Time/Date menu keys used to set and
display the real-time clock:

Key access: [[§#] > More

Time/Date  Toggles the time/date display between on and off.
On Off

Date Format Changes the display format of date from
MDY DMY  month-day-year to day-month-year.

Set Time sets the time of the real-time clock. Enter the time in
24 hour HHMMSS format. Valid hour (HH) values are
from 00 to 23. Valid minute (MM) and second (SS)
values are from 00 to 59.

Set Date sets the date of the real-time clock. Enter the date in
the YYYYMMDD format. Valid year (YYYY) values are
0000 through 9999. Valid month (MM) values are
from 01 to 12, and valid day values are from 01 to
31.

Toggles the 10 port between USB, LAN and GPIB(option) for remote
control.
Key access: _Sm:gl > More

Accesses the security system to enable licensing for individual
options. A user may not turn off an option using this system. Once
an option has been licensed for a given analyzer, it cannot be
transferred to a different analyzer.

3 Preset/
Key access: igi#4 > More > More

tem

Option Allows you to key in a three-character option
number. The option number will appear on the
second line of the Option key.

License Key Allows you to key in a license key number. The
license key number appears on the second line of the
License Key softkey.



GPIB Address

VGA OUTPUT

Brightness

IP Admin

N9320A Code
Compatibility

Key Reference

Preset/System
Activate Activates the license for the option whose number was
License previously input in License Key. If the entry is correct,

the option will be enabled and the message: “Option
activated” will appear in the status line of your display.

If the entry is incorrect, the error message “License key
invalid” appears in the status line of the display. Edit
the option and/or license key number until they are
correct.

Sets the GPIB address for the anlayzer.

Key access: S;gse;’, > More > More

Toggles the VGA output port between on and off for video signal
output.
Key access: f#&4 > More > More

System

Adjusts the display brightness between high, middle and low.
Key access: [ > More > More

Access the submenu to configure the TCP/IP parameters for
remote control via LAN, such as: IP address, Static/DHCP IP,
Gateway and subnet mask. Once the setting is finished, press Apply
to activate the configuration.

Key access: §##4 > More > More

When this softkey is set to On, the analyzer is compatible with the
N9320A SCPI command library.

Key access: §454 > More > More

System
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Span

Full Span

Zero Span

Last Span

Demod

Accesses the span function and the submenu softkeys for span
functions. Pressing changes the frequency range
symmetrically about the center frequency. The frequency-span
readout describes the total displayed frequency range. To
determine frequency span per horizontal graticule division, divide
the frequency span by 10.

Enter the span frequency range value.

Key access:

Changes the span to full span showing the full frequency range of
the analyzer. Full span sets Signal Track, Marker function off.

Key access:

Changes the frequency span to zero. In this mode, the current
center frequency is displayed in the time domain (the x-axis is
displayed in units of time), like a conventional oscilloscope. Zero
span sets Signal Track (Off).

Key access:

Changes the span to the previous span setting.

Key access:

Accesses the menu keys to select AM demodulation, FM
demodulation. It also accesses the Speaker Vol softkey
described below.

Key access:

The Demod menu key only appears when the SPAN is set to Zero
Span.



AM
On Off

FM
On Off

Speaker Vol

Key Reference
SPAN

Activating AM demodulation turns off FM
demodulation (if it is on).

Key access: > Demod

Turning FM demodulation on turns off AM
demodulation (if it is on). For best results, Turn on
the optional Internal Preamplifier, set the RBW to
100 kHz and Attenuation to 0 dB.

Key access: > Demod

Press this softkey to set the speaker volume of
the demodulated signal.

Key access: > Demod
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Sweep/Trig
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Sweep Time
Auto Man

Sweep
Single

Sweep Cont

Accesses the Sweep/Trigger softkeys for selection of the sweep
mode and trigger mode of the analyzer. The softkey menu
selections are defined as follows:

Selects the length of time the analyzer takes to tune across the
displayed frequency span (or, in zero span, the time the analyzer
takes to sweep the full screen). Reducing the sweep time increases
the sweep rate. Change the sweep time by using the arrow keys,
the knob, or the numeric keypad.

In non-zero spans, when the sweep time is auto-coupled, the
analyzer selects the optimum (shortest) sweep time for the current
settings. This selection process is influenced by several factors:

The max. tuning rate of the spectrum analyzer

The selected resolution and video bandwidth filters

The max. sample rate of the analog-to-digital converter

The number of trace points

The amplitude scale (logarithmic or linear)

The detector mode

The user may select a sweep time less than the auto-coupled
value; however this may generate measurement errors. The
minimum sweep time is 50 ms.

In zero span, the minimum sweep time is determined by the
maximum sample rate of the ADC and the number of sweep points.
The minimum sweep time is 2 microseconds. The maximum sweep
time is 4000 seconds.

Key access:

Pressing Sweep Single puts the analyzer in single-sweep mode.
Press Sweep Single to initiate a sweep when in single-sweep mode.

Key access:

Selecting continuous sweep causes repeated sweeps to be
triggered. Pressing Preset (When Preset Type is set to Factory) sets
the sweep mode to continuous sweep.

Key access:



Free Run

Video

External Pos

External Neg

Trig Offset
On Off

Key Reference
Sweep/Trig

New sweep starts as soon as possible after the current sweep ends.

Key access: & > More

Activates the trigger condition that starts the next sweep if the
detected RF envelope voltage rises to a level set by the video
trigger level. When Video is pressed, a line appears on the display.
The analyzer triggers when the input signal exceeds the trigger
level at the left edge of the display. Change the trigger level by
using the arrow keys, the knob, or the numeric keypad.

Key access: [ > More

This function is not available when the Resolution Bandwidth is
less than 1 kHz. Selecting a Resolution Bandwidth less than 1 kHz
while in Video Trigger mode, changes the Trigger mode to Free
Run.

Activates the trigger condition that will start a sweep when the
external voltage (connected to EXT TRG IN on the rear panel)
passes through approximately 2 volts. The external trigger signal
must be a 0 V to +5 V TTL signal. Sets the trigger polarity to
positive.

Key access: ¥4 > More

Sets the trigger polarity to negative.

Key access: [ > More

Allows you to set and turn on or off an offset value from the trigger
point of the sweep at which to begin storing data in the trace of the
analyzer. The offset is specified as a function of time, and permits
positive (pre trigger) and negative (post trigger) values to be
specified.

Key Access: E8EE > More

This function is only available when in Zero Span. The value and
state is saved if Zero Span is exited and restored when Zero Span is
reselected.
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Select Trace
1234

Clear Write

Max Hold

Min Hold

View

Blank

Accesses the trace keys to store and manipulate trace information.
Each trace consists of a series of points in which amplitude data is
stored. The analyzer updates the information for any active trace
with each sweep.

Selects the trace for current use.
Key access:

Erases any data previously stored in the selected trace, then
continuously displays any signals during each sweep of the
analyzer. This function is activated for trace 1 at power-on and
Factory Preset.

Key access:

Retains the maximum level for each trace point of the selected
trace. Updates the trace point value if a new maximum level is
detected in successive sweeps.

Key access:

Retains the minimum level for each trace point of the selected
trace. Updates each minimum trace point if a new minimum level is
detected in following sweeps.

Key access:

Holds and displays the amplitude data of the selected trace. The
trace register is not updated as the analyzer sweeps. press View to
retrieve a stored trace previously deactivated by pressing Blank.

Key access:

Stores the amplitude data for the selected trace, then removes the
trace from the display. The selected trace register no longer
updates as the analyzer sweeps. To activate this function for traces
2,3 and 4 at power-on press Preset (when Preset Type is set to
Factory and Factory Def).

Key access:



Trace Math

Key Reference
Trace

This softkey provides a submenu for the traces operation.
Key access:

Variable A, B, C  Press those softkeys to select a trace (for variable
A,B, and C) or a display line (for variable A and B) for the trace
calculation.

A-B-> C Turn this softkey on to calculate variable A minus
variable B. The result will display as variable C when all the
variables is set to on. This function and A+B->C can not be set to
on simultaneously.

A+B->C Turn this softkey on to calculate variable A plus variable
B. The result will display as variable C when all the variables is set
to on. This function and A-B->C can not be set to on
simultaneously.

Math By This softkey toggles the caculation type between power
and logarithmic power. When it is set to power, the variable A and
B will be calculated in power and the result variable C will display
in converted logarithmic power. When it is set to log power, the
variable A and B will be calculated in lograithmic power and the
result variable C will display in logarithmic power.
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Overview

Overview

If an improper operation occurs during the instrument
configuration, a message will appear on the status line indicating
the incident and the how the spectrum analyzer corrected the
setting automatically. press §#&s4 > More > Show errors to read the

specific descriptions of those messages.

Example

In this example, a failure explanation is generally included with
each error to further define its meaning. The instrument messages
in this guide are listed numerically.

<Number> <Code> <Message>

1.

172

Self-test failed

A self-test failure occurred.

<Explanation in manual>
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Command Errors

-100

-107

-102

-103

104

-108

-109

-110

The messages listed below are command errors, which are saved
into local registers.

Command error

An unrecognized command or data type was encountered. This
message is used when the device cannot detect more specifics
described for errors -107 to -109.

Invalid character

A syntactic element contains an invalid character.

Syntax error

An unrecognized command or data type was encountered.

Invalid separator

The parser was expecting a separator and encountered an illegal
character.
Data type error

The parser recognized a data element that is not allowed.

Parameter not allowed

More parameters were received than expected for the header. For
example, the *ESE common command only accepts one
parameter, so receiving *ESE 0,1 is not allowed.

Missing parameter

Fewer parameters were received than required for the header. For
example, the *ESE common command requires one parameter, so
receiving *ESE is not allowed.

Command header error

An error was detected in the header. This message is used when
the device cannot detect more specifics described for errors -111
to -119.
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-112

-113

-128

-130

-131

134

-138

-144

-148

Program mnemonic too long

The header contains more than 12 characters.

Undefined header

The header is correct in syntax, but it is undefined for this device.

Numeric data not allowed

A legal numeric data element was received, but the device does
not accept one in this position for the header.

Suffix error

This error is generated when parsing a suffix. This message is used
when the device cannot detect more specifics described for errors
-131 to -139.

Invalid suffix

The suffix does not follow the syntax described in IEEE 488.2, or the
suffix is inappropriate for the device.

Suffix too long

The suffix contained more than 12 characters.

Suffix not allowed

A suffix was encountered after a numeric element which does not
allow suffixes.

Character data too long

The character data element contains more than 12 characters.

Character data not allowed

A legal character data element was encountered where prohibited
by the device.
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Execution Conflict

Execution Conflict

-200

-222

-223

-224

-247

-253

-300

The system messages listed below are execution conflicts,
indicating settings conflict during your operation.

Execution Error
This is the generic syntax error for devices that cannot detect more
specific errors.

Data out of range

A legal program data element was parsed but could not be
executed because the interpreted value was outside the legal
range defined by the device. The displayed results may be clipped.

Too much data not all points entered

Indicates that a legal program data element of block, expression, or
string type was received that contained more data than the device
could handle due to memory or related device-specific
requirements.

Illegal parameter value
An attempt was made to select a user file that contains O bits.
Select another user file that contains at least 1 bit.

Hardware missing

Missing device hardware. For example, the RF board is not
installed.

Corrupt media

A source media (possibly EEPROM) for a data file is corrupt. This
error is usually seen in conjunction with errors concerning a certain
file.

Device-specific error

This is the device-specific error for devices that cannot detect more
specific errors.
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-330  Self-test failed

A self-test failure occurred. Report this error to Keysight
Technologies.

-340  calibration failed

An expected file was not found while trying to load internal
calibration.
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Device-Specific Errors

102

104

105

201

204

211

213

214

Set 50 MHz signal < 0 dBm, do alignment again

The 50 MHz energy is too high at the RF port for alignments to run.
Reduce input power to less than 0 dBm and run alignments again.

1st LO Unlock

The first LO on has lost phase lock. Report this error to the nearest
Keysight Technologies sales or service office.

2nd LO Unlock

The second LO has lost phase lock. Report this error to the nearest
Keysight Technologies sales or service office.

Option not installed

The desired operation cannot be performed because a required
option is not installed.

TG Frequency Limit

The tracking generator has reached the limit of its allowable
frequency range.

RBW limited to 1 kHz when Span > 1 MHz

In spans greater than 1 MHz, narrow (digital) resolution
bandwidths, below 1 kHz, are not available.

Span limited to T MHz when RBW < 1 kHz

In narrow (digital) resolution bandwidths, below 1 kHz, spans
greater than 1T MHz are not available.

TG start freq is less than 9 kHz

Tracking generator uncalibrated below 9 kHz.
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215

224

238
501

502

604

605

610

612

651

652

TG start freq is less than 1/2 res bw

Tracking generator uncalibrated at start frequencies below 1/2 the
current resolution bandwidth.

Option not licensed

The selected option requires a license. Refer to the installation
procedures in the user guide provided for this particular option.

VBW filter or Average Detector cannot use both

RF over load

Either increase input attenuation or decrease the input signal level.
IF over load

Either increase input attenuation or decrease the input signal level.

File already exists

You attempted to save to a file that already exists. Either delete or
rename the existing file or select a new name, then try again.

Media is protected

A save was attempted to a write-protected device.

File access is denied

The file is protected or hidden and cannot be accessed.
File not found

The analyzer could not find the specified file.

Connect TG OUT to RF IN

Attempt to align the tracking generator without its output
connected. Connect the TG SOURCE to RF IN.

Connect CAL OUT to RF IN
you must connect the CAL OUT to RF IN with the appropriate cable.



751

752

753

757

758

760

762

764

767

Instrument Messages
Device-Specific Errors

Instrument state set to initial values

While trying to load a trace or state, the state information was
found to be in error. This may be because the state had been
stored on a later revision of analyzer firmware. A default set of state
variables was loaded instead. There is nothing wrong with the
analyzer.

Unable to load state from file

Attempt to load a state from a file failed.

Unable to save state to file

Attempt to save a state to a file failed. See the associated error
messages for the cause.

Unable to load user state

A user preset failed, so the factory preset values were used. Save a
valid state into user preset and try again.

Unable to save user state

Attempt to save a user preset state failed.

Unable to query state

Query of state over the remote interface was unsuccessful.
Unable to load file

A failure occurred while loading a file.

Unable to save file

Attempt to save a file failed; the file was not saved.

Fatal LDS error

Attempt to initialize the instrument state has failed. Cycle
instrument power. If this fails to correct the problem, contact your
nearest Keysight Technologies service center.

179



Instrument Messages
Device-Specific Errors

180

768

770

780

781

782

783
784
805

Unable to load user state

Attempt to load a state failed, because the state was saved
with a measurement personality that is not currently loaded. Load
the appropriate personality and try again.

Incorrect filename

You sent a remote command to save a screen file but did not
specify a valid extension.

No Peak Found

No signal peak was found that meets the criteria under RS >
Search Criteria.

Video Trigger cannot be active

You sent a remote command to do one of the following:

Turn on video trigger while the Average Detector or a Marker
Function is active.

Turn on the Average Detector or a Marker Function while Video
Trigger is active.

Video Trigger cannot be used with Mkr Func

Due to the Average Detector, the video Trigger cannot be used
with Maker function.

Allowable span for current CF exceeded
Allowable CF for current span exceeded

Doing Alignment
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6  Troubleshooting

This chapter includes information on how to check for a problem with your
Keysight Technologies spectrum analyzer, and how to return it for service.

If you experience a problem or would like additional information about your
analyzer, Keysight Technologies’ worldwide organization is ready to provide
the support you need.

KEYSIGHT

TECHNOLOGIES
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Check the basics

Before calling Keysight Technologies, or returning an analyzer for
service, perform the quick checks listed below. This check may
eliminate the problem.

Is there power at the receptacle?

Is the analyzer turned on? Listen for internal fan noise to
determine if the analyzer cooling fan is running. Feel the rear
side of the analyzer for air flow.

If other equipment, cables, and connectors are being used with
your spectrum analyzer, make sure they are connected properly
and operating correctly.

Review the measurement procedures being performed when the
problem first appeared. Make sure all of the settings are correct.

If the analyzer is not functioning as expected, return the
analyzer to a known state by pressing Preset.

Some analyzer settings are not affected by a Preset. If you wish to
reset the analyzer configuration to the state it was in when it was
originally sent from the factory, press System, Power On/Preset,
Preset Type, Factory. Then press the green Preset key on the front
panel.

Is the measurement being performed, and the results that are
expected, within the specifications and capabilities of the
analyzer? Refer to the Technical Overview for your analyzer.

Is the analyzer displaying an error message? If so, refer to User’s
Guide for details.

To meet specifications, the analyzer must be aligned. For more
information on how to align the analyzer, refer to “Perform a
Time Base Calibration” on page 23.

m No operator serviceable parts inside. Refer servicing to qualified
personnel. To prevent electrical shock, do not remove covers.
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If the analyzer is still under warranty or is covered by a
maintenance contract, it will be repaired under the terms of the
warranty or plan (the warranty is located at the front of this
manual).

If the analyzer is no longer under warranty or is not covered by an
Keysight Technologies maintenance plan, Keysight Technologies
will notify you of the cost of the repair after examining the analyzer.

If a problem persists, please contact the Keysight Technologies
office for further information and service.

Warranty and Service Options
Keysight N9320B spectrum analyzer provides 1-year
return-to-Keysight warranty as standard.

Keysight Technologies offers several optional maintenance plans to
service your analyzer after the warranty has expired:

R-51B-001-3C

extends this service to 3 years.

R-50C-071-3

Keysight calibration upfront support plan, 3-year coverage.

The calibration cycle of N9320B spectrum analyzer is one year.

A button cell provides power to the real time clock of the
spectrum analyzer. It is not rechargeable. If you find your
N9320B encounters a clock defect, please contact your nearest
Keysight Customer Contact Center (CCC) for service.
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Troubleshooting
Contact Keysight Technologies

Contact Keysight Technologies

Keysight Technologies has offices around the world to provide you
with complete support for your spectrum analyzer. To obtain
servicing information or to order replacement parts, contact the
Keysight Technologies customer contact center listed below. In any
correspondence or telephone conversations, refer to your spectrum
analyzer by its product number and full serial number.

Press > More > Show System to find those information.

Online assistance: http://www.keysight.com/find/assist

United States Canada China

(tel) 800 829 4444 (tel) 877 894 4414 (tel) 8008100189

(fax) 800 829 4433 (fax) 800 746 4866 (fax) 800 820 2816

Europe Japan Korea

(tel) +31 20 547 2323 (tel) +81 426 56 7832  (tel) 080 769 0800

(fax) +31 20 547 2390  (fax) +81 426 56 7840  (fax) 080 769 0900

Latin America Taiwan Australia

(tel) +1 (305) 269 7500  (tel) 0800 047 866 (tel) 1 800 629 485
(fax) 0800 286 331 (fax) +61 (3) 9210 5947

Other Asia Pacific Countries

(tel) +65 6375 8100

(fax) +65 6755 0042
Email: tm_ap@keysight.com
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Menu Maps

/ Menu Maps

This chapter provides a visual representation of the front panel keys and their
associated menu keys (in Spectrum Analyzer mode). Refer to Chapter 4, Key
Reference,” on page 89 for key function descriptions.

The name editor menu is shown separately, though it is accessed when
entering data for many keys. The front-panel key menus appear in alphabetical
order as follows.

KEYSIGHT

TECHNOLOGIES
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Menu Maps
Amplitude Menu

Amplitude Menu

Amplitude J

Ref Level Y Axis Apply Corrections Freq Interp
Units On off Log Lin
Attenuation Ref Lvl Offset Antenna Corrections
Auto Man [OFF] File

Scale/Div Corrections Cable

[OFF]

Scale Type Att Limit Other

Log Lin On Off [OFF]
Scale Ext Amp Gain User Delete All
On off [OFF] Corrections
More |¢—p More
More | More Return Return

10f2 2 of 2
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BW/Avg Menu

BW/
Avg

Menu Maps
BW/Avg Menu

Res BW
Auto Man

Auto

Video BW
Auto Man

Video Avg

VBW/RBW
Auto Man

Pwr Avg

Average
On Off

Avg Type >
Auto Man

EMI Res BW

Sweep Type
Swept  FFT
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Menu Maps
Det/Display Menu

Det/Display Menu

188

Det/
Display

Detector >
Auto Man

Active Fctn
Position>

Display Line
On off

Limits >

v

Limit 1 >

Limit 2 >

l

Delete All
Limits

Return

Y

v

Top Auto

Center POSitiVe

Peak

Bottom Negative

Peak

Average

Video RMS

Sample

Normal

I

Type Point
Upper Lower

Limit Frequency
On Off

Test Amplitude
On Off

Margin Connected To

On Off Previous Pt
Edit >

Delete Limit Delete Point

Return Return




File Menu (1 of 2)

Menu Maps

\ 4 ?

Catalog> By Date All
Save Type> By Name Screen
Load Sort> State
Delete> Trace
Copy Local Order Limits

Up Down

USB

Return Return
L, Save Now Delete Now By Date
Type> Type> By Name

Sort>
Name Order
Up Down
Return Return Return Return

File Menu (1 of 2)
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Menu Maps
File Menu (2 of 2)

File Menu (2 of 2)

’@
~—
y v
Catalog Load Now N By Date
Save> Type> By Name
Load> Sort> || State
Delete> Destination> | Trace
Copy> Order Limits
I Up Down
Return Return
a.
v v v
Copy Now By Date All Trace 1 Limit 1
Type> [~ By Name Screen Trace 2 Limit 2
Sort> State Trace 3
Trace Trace 4
Order Limits
Up Down
Return Return

a. This menu is only availabe for the trace file.
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Menu Maps
Frequency Menu

Frequency Menu

Frequency

Center Freq

Start Freq

Stop Freq

CF Step
Auto Man

Freq Offset

Signal Track
On  Off
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Menu Maps
Marker Menu

Marker Menu

Marker
Select Marker > Freq Counter > Freq Counter Delta
123.12 | | [ ] On Off On Off
Normal Resolution Delta Pair
Auto Man Ref Delta
Delta > | | Phase Noise > | Span Pair
Span  Center
Off Opti @ Noise
On Off
All Off Marker Noise
On off
Funtion >
More Return Return
10f2
Select Marker > . on | L Phase Noise Offset
1 On Off -30KHz 30kHz
Marker Trace off Offset Offset
Auto1234 Manual -50KHz 50kHz
Prev Page Offset Offset
-1KHz 1kHz -100KHz 100kHz
Next Page Offset Offset
-10KHz  10kHz -IMHz 1MHz
Offset
-20KHz 20kHz
Marker Table > More | More
10f2 20f2
More Return Return
20f2




Menu Maps
Marker-> Menu

Marker-> Menu

Mkr-> CF

Mkr-> CF Step

Mkr-> Start

Mkr-> Stop

Mkr-> Ref Lvl
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Menu Maps

Measure Menu (1 of 2)

Measure Menu (1 of 2)

194

Meas Avg Number X dB Avg Number
v On Off On Off
Measure Off Avg Mode Avg Mode
Exp Repeat Exp Repeat
Channel Power Max Hold Integ BW
On Off
Occupied BW > Occ BW% Pwr Chan Pwr Span
ACP > O0BW Span
Intermod > More |<—» More
(TOn)
Spectrum
Emission Mask Return Return Return
v
Avg Number Offset
On Off ABCDEF
Avg Mode Method Offset Freq
Exp Repeat IBW RBW On Off
Chan Integ BW Total Pwr/PSD Ref BW
Auto Man
Offset/Limits > | | Limits Pos Offset Limits
On  Off
Meas Type Neg offset Limits
Total Pwr PSD
More |€» More
Return Return

a. Continued on sheet 2 of 2




Measure Menu (2 of 2)

Menu Maps
Measure Menu (2 of 2)

Measure Off

Channel Power

Occupied BW >

ACP >

Intermod >
(TOI)

Spectrum
Emission Mask

Avg Number Total Pwr Ref ! Chan Integ BW »| Absolute
On Off
Avg Mode PSD Ref Chan Span Relative
Exp Repeat
TOI Span Sweep Time Abs AND Rel
Auto Man
Max Mixer Lvl Res BW Abs OR Rel
Auto Man Auto Man
Total  Pwr/PSD
Ref
Return Return
Avg Number Offset Offset Offset
On Off ABCDEF ABCDEF ABCDEF
Meas Type > Start Freq Abs Start Fail Mask
On Off | Absolute Relative
Ref Channel > Stop Freq Abs Stop Meas BW
Couple Man
Offset/ Limits > Sweep Time Rel Start
Auto Man
Res BW Rel Stop
Auto Man Couple Man
More > More PEY More
10f3 20f 3 30f3
Return Return Return Return
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Menu Maps

MODE - Tracking Generator

MODE - Tracking Generator

196

I
Spectrum Amplitude TG Power Sweep Store Ref
Analyzer On off On Off (1->3)
Tracking Attenuation Normalize
Generator Auto Man On  Off
Power Meter Amptd Offset Normalize Norm Ref Lvl

AM Modulation Amptd Step Tracking Peak Norm Ref Posn
Analysis Auto Ma

FM Modulation Man Track Adj Ref Trace
Analysis View Blank

ASK Modulation More More
Analysis

ASK Modulation Return Return Return
Analysis




MODE - Power Meter

Menu Maps

MODE - Power Meter

Zero
MODE > Power Meter
Zero Type
L INT EXT o a
Zero/Cal OU 0 ang;
j Dis Range n
Meas Disp ) FLiJange
Resolution ower Upper
Meas Setup [
Disp Mode Limits
Meter  Char On off
Preset -

Chart View Upper Limit
Pause Lower Limit
> Freq Limit Beep

Power Range
Rel
Limits On Off
Offset
Rel/ Offset On Off
Average Average
On off
Meas Interval Avg count
Auto Man
Return Step Detect
On Off
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Menu Maps

MODE - AM/FM Modulation Analysis

MODE - AM/FM Modulation Analysis

MODE

198

AM/FM
Modulation
Analysis

Carrier Freq Auto Scale L Peak+
On Off
IFBW Ref Value Peak-
EqLPF Ref Position Peak+2/2
Detector L Scale/Div RMS
X Scale | _| * Ext Gain
Peak Hold
Y Scale || sal ot
More Return Return
CarrFreq Step Limit Attenuation
On off
Average CarrPow Upr Preamp
On off On  Off
Limits AMDepth Up/
FreqDev Up
Auto CarrFreq AMDepth Low/
On Off FreqDev Low
Sweep CarrFreq Off Up
Single Cont
Single
More [« > More

* Ext Gain is only available in Y Scale submenu.




MODE - ASK/FSK Modulation Analysis

Menu Maps

MODE - ASK/FSK Modulation Analysis

MODE
ASK/FSK Carrier Freq Auto Scale Symbol Meas Filter
Modulation On Off
Analysis .
Symbol Rate Ref Value Waveform Ref Filter
Filter Setup Ref Position ASK/FSK' Error Alpha/BbT
View Scale/Div Eye Diagram Filter Symbols
X Scale * Ext Gain
Y Scale
More Return Return
Meas Length Limit Free Run CarrFreq Step
On Off
Average CarrPow Upr RF Trigger Auto CarrFreq
On Off On Off
Trigger ASK Depth Up/ EXT Rise Attenuation
FreqDev Up Auto Man
Limits ASK Depth Low Ext Fall Preamp
/ On Off
Sweep CarrFreqOff Up Trig Delay
Single Cont On Off
Single
More More

* Ext Gain is only available in Y Scale submenu.
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Menu Maps
Name Editor Menu

Name Editor Menu

ABCDEFG

HIJKLMN

OPQRSTU

VWXYZ

Return
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Peak
Search

Peak Search Menu

4

Menu Maps

Peak Search Menu

—>

Max Value

Excursion
& Threshold

Peak Search Peak _
Excursion
Next Peak Peak
Threshold
Next Pk Right Threshold
Hidden
Next Pk Left Peak Search
Type >
Min Search
Pk-Pk Search
More Return
10f2
Continuous Pk Peak Table
On off On Off
N dB Points Peak Sort
On 0ff Freq  Amptd
Search
Criteria >
Peak Table >
More
2 of 2 Return
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Menu Maps

Preset/System Menu

Preset/System Menu

202

A4
Presat/ Preset Alignment> P Align (Ext Cable) Power On
Svstem Last Preset
Pwr on/Preset Preset Type> []
Alignment > Save User
Preset
Language> Timebase
CAL OUT
U d Load default
pgrade oad defaults on  Off
Diagnostics>
1|\/I0frg Return Return Return
or .
v v v
Show System Prev Page User
Show Hardware Next Page Factory

Show Software

Show Errors>

Factory Def.

Front Panel Test

Time/Date> [ |
10 Configure Clear Error Queue
More
Ret
2 of 3 eturn
| | . }
Licensing > Sys Name Option Time/Date
On Off
VGA Output IP Address License Key Date Format
On  Off MDY DMY
GPIB Address IP Select Activate Set Time
Static DHCP License
Brightness Gateway Set Date
IP Admin | | Subnet Mask
N9320A Code Apply
Compatibility
More Return Return Return
30f3




SPAN Menu

Menu Maps

SPAN Menu
SPAN

Span AM
On off
Full Span FM
On off
Zero Span Speaker Vol

Last Span

Demod
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Menu Maps
Sweep/Trig Menu

Sweep/Trig Menu

204

Sweep Time Free Run
Auto Man
Sweep Video
Single
Sweep External Pos
Cont

External Neg
More More
1 of 2 2 of 2




Menu Maps

Trace Menu
Trace Menu
Trace T Variable A
— race math Ly
1234 Trace 1
Clear Write Variable B
Trace 2
Max Hold Variable C
Trace 3
Min Hold A-B->C
On Off
View A+B->C
Blank Math By
LogPWR Pwr
More Return
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Menu Maps
Trace Menu

206
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TECHNOLOGIES

Numerics

3GPP W-CDMA, 134
802.11a, 135
802.11b, 136

A

Abs Start, 137
Abs Stop, 137
Active Fctn Position, 102

adjacent channel power, 127

Alignment, 160

running, 18
Amplitude key, 90
annotation, marker, 31
Attenuation, 90
attenuation, reducing, 41
Auto Tune key, b5, 94
Average, 98

B

Back, 95
BW/Avg key, 96

C
Catalog, 107
CE mark, 10
Center Freqg, 113
CF Step, 113
channel power, 122
comparing signals
off screen, 34
on the screen, 32
Continuous PK, 155
Copy, 111
CSA mark, 10

D

Delete, 111

delta marker, 115
Det/Display key, 100
Detector, 100

Display Line, 102, 103
distortion, measuring, 50

E

Enter key, 106

error message, 18
ESD, 22

external reference, 24

F

factory preset state, 159
Fail Mask, 137

File key, 107

firmware revision, update, 25

frequency counter, 117
front panel

overview, 4
front panel, using, 28

H

harmonic distortion
measuring, 50

improving frequency resolution and

accuracy, 46

instruction manual, 10
instrument messages, 171
Int Preamp, 91

ISM1-A, 10

L

Licensing, 162
Limits, 103
Load, 109

M
Marker key, 115
Marker Table, 120
Marker-> key, 121
Max Mixer lvl, 131
Meas key, 122
measuring

ACP, 127

channel power, 122

distortion, 50

low-level signal, 41
multiple signals, 32
occupied BW, 124
SEM, 132
source’s frequency drift, 48
TOI, 53,130
measuring phase noise, 56
menu maps, 185
messages, 18
Min Search, 155
MODE key, 139

N

N dB Points, 155
Next Peak, 154

0
occupied BW, 124
Offset/Limits, 128, 134
options, 13
enable, 24
licensing, 162
order list, 12

P

Peak Search key, 154
Peak Table, 157
Phase Noise, 117
phase noise, measuring, 56
power cord, 15
power requirements, 15
Preset, 158
preset

factory, 29

user, 29
Preset/System key, 158
Pwr on/Preset, 160

R

rack mount, 20
Ref level, 90

Rel Start, 137
Rel Stop, 137
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TECHNOLOGIES

requirements
ventilation, 19

Res BW, 96

resolving signals
equal amplitude, 36
hidden by large signals, 39

S

Save, 108
Scale/Div, 90
Search Criteria, 155
Show System, 161
Signal Track, 114
SPAN key, 164
spectrum emission mask, 132
Start Freg, 113
Stop Freqg, 113
Sweep/Trig key, 166

symbols, 10

T

Threshold Hidden, 156
TOI

Meas key, 130
measuring, 53

TOI Span, 131

tracking drifting signals, 48

U

Uncoupled, definition, 44
using frequency counter, 46

\Y

VBW/RBW, 97
ventilation, 19
Video BW, 96
View/Trace key, 168
viewing signal, 30

W
WEEE, 10
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